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About This Guide

Purpose
This guide is designed as a reference for people who provide postsale technical
support for  HP ScanJet 4Si scanners.  This guide provides answers to frequently
asked questions. 

Use this guide with other product documentation, such as the product notes
available from HP FIRST, the HP facsimile information retrieval system.  To
retrieve HP FIRST information via your fax machine, call (800) 333-1719.  Use the
Administrator’s and User’s Guides and other documents available with the product
or separately from HP.

Organization
This guide uses the standard format for an HP Technical Support Solutions Guide
(TSSG).  TSSG documents contain information about the product and its
installation, operation, problem resolution, and service and support.
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Product Positioning

The HP ScanJet 4Si scanner is the first network scanner that captures paper-based
information in electronic form for distributing, sharing, and filing within a
workgroup.  It is a high-speed, 300 dpi scanner that attaches directly to Novell
NetWare networks.  It includes an automatic document feeder that feeds paper at 15
pages per minute, and desktop software, including optical character recognition
(OCR).  The desktop software is licensed for use by 20 users.

The HP ScanJet 4Si scanner users are small to medium Novell networked
workgroups (5-20 seats) in information-intensive departments of medium to large
companies. Users are the corporate sharer and corporate communicator.

The HP ScanJet 4Si scanner takes advantage of the networked office to provide
better productivity for the workgroup. It is accessible and easy to use by all of its
members.  The HP ScanJet 4Si scanner is the most cost-efficient method for a
networked workgroup to convert hardcopy information into an electronic format
and add it to e-mail or groupware applications. The benefits for the workgroup are
increased productivity and efficiency.

Network scanning or “scan-to-share” is entirely different from traditional scanning.
A networked scanner’s primary purpose is to improve communication in a
workgroup environment through electronic distribution and sharing of documents.
Network scanners also facilitate the management of information. Traditional
scanners are used primarily for desktop publishing and graphics purposes.

Product Description 
The HP ScanJet 4Si scanner enables users to “pick-up” information printed on
paper, turn it into an electronic format and attach it to e-mail messages for further
distribution, plug it into groupware databases, or turn it into editable computer text
to improve or create new documents. 

In most instances, users walk to their scanning station, select their name, scan the
document, return to their computer, and see the scanned document as a “thumbnail”
on a desktop to be dragged and dropped on an application icon for further
processing.  The scanner software is commonly used in conjunction with
groupware, e-mail, OCR, store and retrieve, and workflow applications.

The scanner provides users with a direct and seamless connection to their network,
eliminating the need for a dedicated personal computer.  The scanner uses Simple
Network Management Protocol (SNMP) and Management Information Base (MIB),
which ensure network manageability. 
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Network Scanning

The HP ScanJet 4Si scanner can be attached to your network at any location and
provides ease of use, offers network management capabilities, and increases
scanner performance.  Among the benefits of the HP ScanJet 4Si scanner are:

•• Flexible Location—the scanner can be placed anywhere on a network and
eliminates the need to attach the scanner directly to a server or personal computer,
enabling it to be placed closer to your network users.

•• Performance—the scanner performance is improved by fast paper handling
through the Automatic Document Feeder, and network performance is protected by
data compression techniques.

•• Easy-to-Use Software—the scanner comes with three easy-to-use software
packages: HP ScanJet 4Si Administrative Software, for configuring the device, and
other system administrator activities; HP ScanJet 4Si Utility, for determining and
adjusting user settings; and Visioneer PaperPort for manipulating scanned
documents and items.

•• Network Management—the network scanner interface allows remote monitoring;
the scanner appears as an intelligent node on the network and is accessible through
various diagnostic utilities.

Data flows quickly from the HP ScanJet 4Si scanner, using network protocols.

Workgroup scanning uses a network to connect its members to a single scanner,
much like users are connected to a network printer. Data flows from 1) the scanner
to 2) the network file server,  and then to 3) your computer, as shown in Figure 1-1.

Figure 1-1
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Product Features

Performance • 15 ppm at 1 bit/pixel at 300 dpi

• Grayscale definition: 1, 4, and 8 bits/pixel

• 300 dpi optical resolution up to 1200 dpi interpolated at 100% scaling;
1500 dpi at 80% scaling

• Comes with embedded Optical Character Recognition software

• Supports, image scanning, e-mail, fax, and groupware software

Paper Handling • Supports multiple paper sizes:
  - Executive (7.25 x 10.5 inches)
  - Letter (8.5 x 11 inches)
  - A4 (8.3 x 11.7 inches)
  - A5 (5.85 x 8.3 inches)
  - Legal (8.5 x 14 inches)

• Holds up to 50 pages in ADF

• Scans text, graphics, and photos

Software • Visioneer PaperPort software allows users to receive, view, and
manipulate documents scanned with HP ScanJet 4Si scanners

• HP ScanJet 4Si Administrative Software allows network administrators to
quickly configure scanners and their associated user pools and print
queues

• HP ScanJet 4Si Utility software for determining and adjusting user scanner
settings, and monitoring scanner status.

Network Support • NetWare 3.1X and 4.X on IPX (NetWare 4.X only in Bindery Emulation
Mode)

Interface Support • Universal power supply

• 10Base-T Ethernet (RJ-45) and Token Ring (DB-9 or RJ-45) LAN
connector
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Ordering Information

This section provides ordering information for the HP ScanJet 4Si scanner.
Availability and technical information are subject to change without notice. Contact
HP’s North American Distribution Organization (NADO), European Distribution
Operation (EDO), or an HP sales representative to order items.

Original Part Numbers

Scanner Part Numbers
The HP ScanJet 4Si scanner comes in two versions: 

•• Ethernet (C1302A) 
•• Token Ring (C1303A).

The only physical difference between the two versions is the LAN adapter card in
the network box. The LAN adapter card (not a JetDirect card) is not
customer-removable.

Replacement Parts, Accessories and Documentation
You can order replacement parts for the scanner by contacting your sales
representative or the Hewlett-Packard dealer where you bought the scanner. Within
the United States you can order the parts below directly from HP at (800) 227-8164.

Item Part Number*

Scanner power cord 8120-6328

Network box power cord 8120-6328

SCSI cable and terminator C1301-67901

Administrator’s Guide C1301-90900

User’s Manual C1301-90905

Quick Reference Guide C1301-90910

Replacement disks (full set) C1301-60100

ADF delivery guide FB3-0308-000CN

ADF lower rollers FB3-0328-000CN

*Power cord, software, and manual part numbers are U.S.. and Canada only. Contact your HP
dealer for part numbers outside the U.S. or Canada.
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Express Exchange Program

HP’s Express Exchange Program allows customers to exchange faulty modules (as
diagnosed by an HP Customer Support Center).   The ScanJet 4Si scanner is
composed of three modules that the user stacks and connects together.  Usually only
the defective module for the scanner will be exchanged under the Express Exchange
Program.

The support center will be required to determine the faulty module, aided by
information from the control panel (if it is still working).  Service center agents will
require the part number for the faulty module in order to exchange it.  In the cases
where the fault cannot be located in a particular module, the entire scanner unit will
be replaced.

N o t e Authorized dealers are advised to exchange the entire HP ScanJet 4Si scanner unless
the failed module has visible defects or has already been replaced with a unit from stock.

Support Center Tools for Module Exchange
Customer Support Centers will have the following tools to allow diagnosis of
scanner problems down to a module level:

•• Visible Problems—cracked glass, power indicators, switch-on test
•• Control Panel—error codes that appear on the control panel indicate a broken

component
•• Technical Support Solutions Guide (this document)

Check the electronic services listed in Chapter 6, “Service and Support” or the HP Support
Assistant CD-ROM for the latest information on supporting the HP ScanJet 4Si.
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Exchange Assemblies

There are six different “products” that can be sent to a customer when exchanging
an HP ScanJet 4Si scanner: two exchange “units” and four exchange “modules.”
Refurbished parts can be ordered with the part numbers in the table below.

Exchange Assembly Part Numbers

Part Europe U.S./Rest of World

Control Panel + ADF C1301-69901 C1301-69902

Scanner

Also called Scanner Base

C1301-69001 C1301-69002

Network Box (Ethernet) C1304-69001 C1304-69002

Network Box (Token Ring) C1305-69001 C1305-69002

Ethernet Exchange Unit C1302-69001 C1302-69002

Token Ring Exchange Unit C1303-69001 C1303-69002
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Scanner Specifications

Feature Specification

Scanner Type Flatbed

Maximum Document Size Flatbed: 216 x 297 mm (8.5 x 11.7 in.)
ADF: 216 x 356 mm (8.5 x 14 in.)

Scanning Element Charged-coupled device

Light Source Xenon lamp

Interface LAN: Ethernet or Token Ring

Optical Resolution 300 dpi

Scanning Speed 15 pages per minute

Image Processing Options (preset) Text, Photo, Text & Photo

AC Line Voltage 100-240 VAC, 50-60 Hz

Power Consumption 70W maximum

Weight 15.2 kg 

Environmental Ranges

Temperature

Operating 10 to 32.5 oC (50 to 90.5 oF)

Storage - 30 to 60 oC (-22 to 140 oF)

Humidity

Operating 20 to 80% noncondensing (10 to 32.5 oC)

Storage 20 to 80% (0 to 40 oC)
20 to 60% (40 to 60 oC)
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System Architecture

Network Components

A typical workgroup on a LAN has some personal computer client stations, a
Novell NetWare file server, a network printer, and, of course, the HP ScanJet 4Si
scanner. The HP ScanJet 4Si scanner acts as a normal NetWare client. 

The scanning process begins from the network scanner’s front panel. The user
selects the network destination, presses the Start button, and the pages are scanned.
The scanned images are compressed and then transferred to the network server,
where they are stored temporarily on a shared disk in a directory named workarea.

Scanned items are stored in the work area until a user connects to the network.
Each client personal computer can be configured to automatically search for,
import, and display all new scanned documents, or new documents can be imported
and displayed only when Visioneer PaperPort is launched.

Data transfer on the network is transparent to the user. Data are transferred from
the server to the personal computer client using the standard DOS driver I/O to
access network disks. Each new document is completely transferred and
decompressed before it is displayed on the client personal computer.

Figure 1-2
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Software Components

The HP ScanJet 4Si has four main software modules (the first three listed are visible
to the user):

•• HP ScanJet 4Si Administrative Software—system administrator software that
displays the most important information related to all connected and working
network scanners.

•• Visioneer PaperPort 3.0—the desktop (Windows-executable) program.
PAPRPORT.DRV is the virtual device driver.

•• HP ScanJet 4Si Utility—a Windows program that enables end users to customize
their scanning profiles and check the network scanner status.

•• SSNet (DLL)—a Windows .DLL interface between the user applications
(PaperPort desktop and the HP ScanJet 4Si Utility) and the network.

N o t e All of these module run in a Windows station, even if they can be installed on a file
server.  There is no software module to load in the file server (no NetWare Loadable
Module or “NLM”).  See Chapter 4 for additional information on the scanner and
software effects on a network.

Server/Scanner communication via software.

Figure 1-3
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Network Protocols

The HP ScanJet 4Si Administrative Software communicates with the NetWare file
server only through the NCP protocol. The software communicates with the
network scanner only through the SNMP (on IPX) protocol. The following DLLs
(Windows Dynamic Link Library files) are provided with the software: SNMP,
NWCALLS, and NWIPXSPX.  

File System Organization on the File Server
The HP ScanJet 4Si Administrative Software creates its own work directories on
VOL 0 (typically called SYS) on the NetWare server. One directory with several
subdirectories is created during the software installation, as shown below.  The
NetWare Supervisor is the owner of this directory.  The ScanJet 4Si scanner and its
users only have read and find rights on these directories, which is why the
administrative software can be used only with Supervisor privileges, if you want to
perform any kind of configuration activities.

While adding users to the network scanner, the software automatically creates a
subdirectory for each user named WORKAREA.  The software does not use the
group manager concept defined in the NetWare environment.  Each user has
ownership of his/her workarea; the system administrator and the user have full
rights on the user’s workarea.

The system administrator and/or the user can create custom (private) settings that
are saved in the user’s workarea directory.  The software stores newly scanned
items addressed to a user in his/her work area. To retrieve a scanned item, each user
must log in to the file server with his/her user name.

Figure 1-4
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System Requirements

User Systems

•• 80386 or above (486 recommended)
•• 8.5 megabytes of available disk space for local installation (standalone)
•• 0.5 megabytes of available disk space for shared installation (workstation)
•• 4 megabytes for swap file
•• 4 megabytes of RAM (8 megabytes required to use OCR software included with

Visioneer PaperPort)
•• Windows 3.1, Windows 3.11, Windows 95, and Windows for Workgroups 3.11
•• Novell NetWare version 3.1 or above
•• IPX version 3.10 or above
•• NetWare shell version 3.26 or above

Network Server

•• 7 megabytes of available disk space for installation to allow users to run the user’s
software from a local directory

•• 15.5 megabytes of available disk space for installation to allow users to run the
user’s software from a shared directory

•• Bindery Emulation Mode for NetWare 4.x
•• At least one user defined having supervisor equivalency for NetWare 4.x in the

Bindery Emulation Context.

N o t e The network server is used as temporary storage for scanned documents.  Overall
system performance will benefit from larger available disk space (minimum: 10
megabytes; recommended: 50 megabytes).

N o t e The HP ScanJet 4Si scanner uses G4 and Packbits compressions to send data over
the network, which improves performance and reduces disk usage on the server.
When the data arrives at the client work station, it is converted to Visioneer’s
proprietary compression format (.MAX). For more information on file compression,
see Chapter 4, “Effects on Networks.”
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Supported Environments

The HP ScanJet 4Si behaves on the network as any other client personal computer.
The scanner connects to the file server, where it has been configured as any
common NetWare client.  In the server’s Bindery, it appears as a specific-type
NetWare object.  The HP ScanJet 4Si scanner operates in the following
environments:

•• Client Operating Systems
•• Windows 3.1x (except standard mode)
•• Windows for Workgroups 3.11
•• Windows 95 (see section below)

•• Netware shell version 3.26 or above
•• Network protocol: Novell IPX version 3.10 or above
•• Network Operating Systems

•• Novell NetWare 3.1x
•• Novell NetWare 4.x (Bindery Emulation)

•• Network Topologies
•• Ethernet 10Mbps
•• Token Ring 4/16Mbps

Windows 95 Support
The HP ScanJet 4Si scanner software is compliant with but not certified for
Windows 95. All the software for the HP ScanJet 4Si scanner can run on Windows
95; however, the traffic light feature of the HP ScanJet 4Si utility does not function
in Windows 95.

Non-supported Environments
The HP ScanJet 4Si scanner is not supported in the following environments:

•• Non-DOS client operating systems (Mac, OS/2, UNIX)
•• Windows 3.1x standard mode
•• Windows emulations from other operating systems are not certified
•• Netware shell and protocols not provided by Novell
•• Non ODI IP configurations (IPX.COM, NDIS)
•• NetWare/IP
•• No other network operating systems (Windows NT server, LAN server, LAN

Manager, Banyan Vines, peer-to-peer LANs)
•• NetWare for UNIX
•• Other cabling systems (100 VG AnyLAN, FDDI)

Ethernet Frame Type or Token Ring Speed must be preset between the system
administrator’s client PC and the scanner.
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Supported Links

PaperPort links allow users to drag & drop a thumbnail onto an icon to launch an
application. If the application is already running, PaperPort will start a separate new
session of the application.

Some supported links ship with the applications, which means that when you install
the application, the link is added in the Desktop Link toolbar.  These applications
are Caere PageKeeper (version 2.0 and later) and Xerox TextBridge (version 2.8
and later).  For a complete list of applications supported by PaperPort links, see
“Using the PaperPort Software and Links” in Chapter 3.

How Links Work
At startup, PaperPort launches library files to identify supported applications.
These library files (.glk files) are similar to standard .dll files and are located in the
PaperPort directory.  If a .glk file returns “application found,” PaperPort displays
the icon for that application. 

Each .glk file can support one or more applications and contains all the calls
necessary to load and operate the supported link.  There are also generic .glk files
for FAX or TEXT applications; therefore, various word processing applications can
use a common .glk file.

Icons for applications that are not automatically supported by PaperPort can be
displayed if they have their own .glk file.  These applications can also install the .glk
file in their own directory, as long as the proper entry is created in the MAXLIN.INI
file under the Windows directory.

For more information on using PaperPort links, see Chapter 3.
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Your Hewlett-Packard Scanner

This chapter will help you install and configure your scanner and its software.  The
following sections will help you with the following tasks:

•• Unpacking the scanner
•• Identifying package contents
•• Selecting a suitable location 
•• Setting up the scanner for operation
•• Unlocking the scanner
•• Configuring the scanner

HP ScanJet 4Si Scanner

Figure 2-1
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Location Requirements

Top View Side View

Location requirements:

• Space allowance around scanner as
shown

• A sturdy, level surface for
placement.

• Room temperature: 10 to 32.5 C/ 50
to 90.5 F

• No exposure to chemicals or direct
sunlight

• Relative humidity: 20% to 80% • A well-ventilated room

• Stable environment with no abrupt
temperature or humidity changes

• Location free of constant vibrations

C a u t i o n Relock the scanner whenever you move it to prevent damage.  See Step 3 in this
chapter for instructions.

 

Figure 2-2
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Step 1. Unpack the Scanner

Remove the Internal Packaging

1 Carefully unpack the scanner from its box.
2 Remove plastic shipping bags.
3 Remove packaging tape from the automatic

document feeder.

Check the package contents against the
illustrations on the following page and identify the
various scanner parts.

N o t e
Save your box and packaging materials in case you
need to move or ship the scanner later.
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Check the Package Contents

Locate each item listed below:

A Automatic Document Feeder F Scanner Power Cord

B Scanner G Network Box Power Cord

C Network Box H SCSI Interface Cable

D Documentation I SCSI Terminator

E Software Disks

A

D

B

E

C

F

G

H

I

Figure 2-3
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Identifying the Scanner Parts

The following illustrations give the location and names of key scanner parts.

HP ScanJet 4Si scanner, Front View

A Control Panel E Scanner Base Power Indicator

B Input Paper guides F Scanner Base Power Switch

C Automatic Document Feeder G Network Box Power Switch

D Output Paper Stop and Handle H Network Box

A

B

D

C

E

F

G

H

Figure 2-4
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HP ScanJet 4Si scanner, Front View with Cover Lifted

A Automatic Document Feeder D Power switches

B Scanner glass E Network box

C Paper alignment arrow

A

B

C

D

E

Figure 2-5
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HP ScanJet 4Si scanner, Rear View

A ADF Connector Socket G SCSI Terminator Socket

B Scanner Power Connector
Socket

H Scanner SCSI Connector

C Network Box SCSI Connector I ADF Connector Cable

D Control Panel Connector Socket J Control Panel Connector Cable

E LAN Connector (10BASE-T or
Token Ring)

K Control Panel

F Network Box Power Connector
Socket

SCSIPE SCSI
ADF

Figure 2-6
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Step 2. Assemble the Scanner and Network Box

1 Assemble the scanner and network box by
aligning the scanner with the mounting pins
on the network box.  (Verify that the scanner
is aligned on all corners.)

2 Connect  the SCSI interface cable to the
scanner and network box.

3 Connect the SCSI terminator to the scanner.

PE

PE

SCSI

SCSI
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Step 3. Unlock the Scanner

A locking mechanism secures and protects the
internal mirror assembly during shipment.  It must
be unlocked before you can use the scanner.

1 Locate the locking screw near the back of the
scanner.

2 Using a coin, turn the locking screw
90 degrees clockwise.

Relocking the Scanner

C a u t i o n
Relock the scanner whenever you move it to
prevent damage. 

1 Remove the automatic document feeder.

2 Return the light bar to the home position:

• Turn the scanner on.
• Wait until the lamp in the light bar is off.
• Turn the scanner off.

3 Locate the locking screw.

4 Using a coin, turn the locking screw
90 degrees counter-clockwise.
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Step 4. Install the Automatic Document Feeder

1 Hold the automatic document feeder (ADF)
with the mounting posts above the
corresponding holes on the back end of the
scanner.

2 Lower the ADF until the mounting posts are
inserted all the way into the holes and the
ADF is in contact with the scanner.

N o t e
Ensure that all cables are out of the way for proper
installation.

3 Hold the ADF connector cable so that the flat
side is on top to align the plug with the
scanner socket.

4 Plug the ADF cable into the scanner socket.
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5 Plug the control panel cable into the network
box.

6 Attach the power cords to the scanner and
network boxes and plug the other ends into an
electrical outlet.

N o t e
Attach your network interface cable into the
network box:
A) 10Base-T jack (RJ-45) or 
B) Token Ring (DB-9 or RJ-45) 
This cable is not shipped with the scanner.

PE

PE

SCSI

SCSI
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Step 5. Configure the Scanner

The HP ScanJet 4Si scanner can be configured to display another language, change
the default paper size for the Automatic Document Feeder, Token Ring speed, or
frame type. The configuration menus are displayed in the following sequence:  

1 Languages
2 Default Paper Size
3 Token Ring Speed (for Token Ring networks only)
4 Network Frame Type

Figure 2-7 shows the control panel keys: A) Menu, B) Scroll back C) Scroll
forward, D) Start key, E) Stop, and F) Abort.  The following table explains how the
control panel keys work within the configuration menu. 

Key Action

A Menu Key Enters the top level menu so you may select a
parameter value

B/C Scroll Keys Moves through the list of menus and parameter values

D Start Key Saves changes and exits to normal use (from the top
level menu)

E Stop Key Ignores changes and moves to the top level menu

F Abort Key Ignores changes and returns scanner to normal use
(from the top level menu)

Figure 2-7
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To Enter the Configuration Menus
Before you can configure the scanner on the server, use the following steps to
configure the control panel.  The configuration menus allow you to configure the
control panel language, network frame type, token ring speed (token ring networks
only) and paper size. The first value shown in each configuration menu is the
currently selected value.

Use the following power-up sequence to enter the configuration menus.

1 Turn off the network box.

2 Press and hold the stop and abort keys. (Refer to Figure 2-7 for key positions.)

3 Turn on the network box.

4 After a few seconds, release the keys.

5 The scanner control panel displays Self Test Initializing...Wait.  

6 When it is ready for you to enter the configuration menus, the display will read
Press Menu to Select Languages.

N o t e If you do not select the Frame Type correctly, the HP Administrative Software will
not recognize the scanner.

To Select the Display Language
The control panel is capable of displaying in one of six languages: English, French,
German, Italian, Portuguese, or Spanish.  Skip this section if you want the scanner
to display English, which is the factory default.

1 Press [MENU] to enter the Languages menu.  Current Language: English

appears on the control panel.

2 Press a scroll key repeatedly until the desired language appears.

3 Press [MENU] to select the language and return to the top level menu.

4 Press a scroll key to move to the Default Paper Size menu; press the start key to
save changes and return to normal use, or press the stop key to ignore changes and
move to the next menu.

N o t e  The control panel displays its messages in the language you have selected.
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To Select the Default Paper Size
The scanner is capable of setting Letter, A4, or Legal paper sizes as the default
paper size on the control panel.  Skip this section if you want the scanner to boot
with Letter size paper selected, which is the factory default.

1 Press a scroll key until Press menu to select Default paper sizes. appears.

2 Press [MENU] to enter the Default Paper Size menu.  Current Paper Default:

Letter appears on the control panel.

3 Press the scroll forward key repeatedly until the desired paper size appears.

4 Press [MENU] to select the paper size displayed and return to the top level menu.

5 Press a scroll to move to the Token Ring Speed menu (if you have a Token Ring
network) or Network Frame Type menu (if you have a Ethernet network); press the
start key to save changes and return to normal use, or press the abort key to ignore
changes return to normal use.
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To Select the Token Ring Speed (Token Ring Networks Only)
If you have a token ring network, you can select the token ring speed.  Skip this
section if you do not have a token ring network, or if you want the scanner to use
token ring speed 16, which is the factory default.

1 Press menu to select Token Ring speeds appears on the display.

2 Press [MENU] to enter the Token Ring Speed menu.  Token Ring Speed: 16 will
be displayed on the control panel.

3 Press a scroll key repeatedly until the desired token ring speed appears.

4 Press [MENU] to select the token ring speed displayed and return to the top level
menu.

5 Press scroll forward to move to the Network Frame Type menu; press the start key
to save changes and return to normal use, or press the abort key to ignore changes
and return to normal use.

N o t e If token ring speed has been changed, the scanner will automatically reboot after
exiting the Configuration Menu.

To Select the Network Frame Type 
The scanner is capable of operating with the following network frame types:
Ethernet 802.2, Ethernet 802.3, Ethernet SNAP, Ethernet II, Token Ring, or Token
Ring SNMP.  Skip this section if you want the scanner to use the Ethernet 802.3
frame type for Ethernet networks or Token Ring for Token Ring networks, which
are the factory defaults for each network.

1 Press Menu to selet Frame types appears on the display.

2 Press [MENU] to enter the Network Frame Type menu.  Current Frame Type:

Ethernet 802.3 appears on the control panel.

3 Press the scroll forward key repeatedly until the desired frame type appears.

4 Press [MENU] to select the frame type displayed and return to the top level menu.

5 If you have completed your configuration, press the start key to return to normal
use.  Otherwise, press scroll forward to return to the Languages menu, or press the
stop key to ignore changes and return to normal use.

N o t e If the network frame type has been changed during configuration, the scanner will
automatically reboot after exiting the Configuration Menu.
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Hardware Installation Complete

The scanner displays the message ScanJet 4Si unconfigured with the
scanner’s node address on the control panel display. You will need this address
when you configure the scanner on the server (see the following section). If this
message is not displayed, refer to Chapter 5, “Problem Solving,” for more
information.
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Your Scanner Software and Network Connection

This section will help you with the following tasks:

•• Installing scanner software
•• Configuring the scanner on the network
•• Adding end users to the scanner
•• Installing the end user software
•• Selecting configuration options, including enabling copying from the scanner to a

network printer
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Step 1. Install the Scanner Software on the File Server

The HP ScanJet 4Si setup program will copy the HP ScanJet 4Si Administrative
Software to the directory you designate, and will make the user’s software available
for users to install by copying it to the network directory you designate.

The administrators’ software consists of the following:

•• HP ScanJet 4Si Administrative Software - allows administrators to quickly
configure Network scanners, and their associated user pools and print queues.  It
also allows administrators to manage the configured network scanners.

The users’ software consists of the following:

•• Visioneer PaperPort program - allows users to receive, view, and manipulate
documents scanned with the HP ScanJet 4Si scanner.

•• HP ScanJet 4Si Utility - lets end users determine and adjust user settings, and
remotely monitor the network scanner’s status.

To install the software
1 Turn on your computer.
2 Log on to the network with supervisor privileges.
3 Start Microsoft Windows.
4 Insert Disk 1 into the floppy drive (usually A: or B:).
5 Select the File menu from the Program Manager window.
6 Choose Run.
7 Type A:\INSTALL  (or B:\INSTALL ) in the Command Line box.
8 Press [Enter].
9 Follow the instructions on the screen.
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Installing the Administrator’s Software
The HP ScanJet 4Si Administrative Sofware can be installed on any directory on
your system.  You may install it in a shared directory so that network administrators
will be able to run it from any client computer on the network.

Installing Users’ Software
You will need to designate how the users’ software will be run by end users.  You
may allow them to run it from: 

•• Local directory only (Standalone) 
•• Shared directory only (Workstation)
•• Local or Shared (users choose between the items above). 

Allowing users to run the users’ software from a shared directory saves client disk
space resources and allows easier updates of software upgrades;  however, the
software will run slower using this kind of installation.

Allowing users to run the users’ software from a local diretory means the software
to may run quicker; however, it uses more client disk space resources.

If you choose one of the last two options, the setup program will create a directory
to contain the shared programs (under the install directory you specified).

In all cases, the setup program asks you whether it should assign R (read) and F
(file scan) trustees to the EVERYONE group for you.  If you answer NO, then you
will have to do this by hand in order for  users to be able to run the users’ software
install program and the users’ software from the shared network directory.  In this
way you may grant stringent trustees as you think appropriate.
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Step 2. Configuring the Scanner to the Network

Now that you have installed the scanner software, you will need to use HP ScanJet
4Si Administrative Software to connect the scanner to the network.

Run HP ScanJet 4Si Administrative Software
Turn on scanner and network box.  Take note of the address displayed on the
Control Panel.  Double-click on the icon for the HP ScanJet 4Si Administrative
Software, or:

1 Within Windows, select the File menu from Program Manager.
2 Choose Run.
3 Type the path where the software is installed followed by SCANADM.  For example,

X:\HPSSCAN\ADMIN4SI\SCANADM.EXE.
4 Press [Enter].

Connect to a file server
Connect to the file server where you want to configure the scanner (if you are not
already connected), following the instructions below.

N o t e If you are logged in with Supervisor privileges, you can use the File Server
Connection window to see the Connected Servers list.

1 Select the Server menu.
2 Choose Connect. 
3 Highlight the server you desire in the Available File Servers list.
4 Click <<Attach.
5 Choose a user with Supervisor rights.
6 Enter the password.
7 Click Close.

N o t e You can use the <<Attach button to change your login account on a server already
listed in the connected servers list (if, for example, you were logged in without
supervisor equivalency).
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Configure the scanner
Choose the scanner you want to configure by highlighting its row on screen. If you
do not see your new scanner, make sure you have set the frame type correctly (See
Configure the Scanner on page 2-13). The unconfigured scanner can be identified
by the node address that is the same displayed on its control panel.

1 Select the Scanner menu.
2 Choose Configure.
3 Enter a name for the scanner in the Scanner Name field. 

N o t e The scanner name may be up to 29 characters in length.  It cannot contain spaces,
slashes (/), backslashes (\), colons (:), semicolons (;), question marks (?), asterisks
(*), or commas (,).

4 Type a description of the scanner (up to 128 characters) in the Description field
(optional).

5 Select the server name from the Server list.
6 Choose whether to display the user’s NetWare full names or NetWare login names

on the scanner’s control panel. 

N o t e User names are displayed up to 20 characters, the maximum control panel width.
For NetWare 4.0x users, the option is not enabled and you must choose login
names. For NetWare 4.1x, the user’s surname is used instead of the full name.

7 Click OK.

N o t e If a message appears warning you that a scanner entry with that name is already
stored on the server, abort the operation and change the name assigned to the
scanner, unless you are restoring a damaged unit or replacing it with a new one.  If
you are restoring or replacing a unit, you will not need to reassign the users to the
scanner.
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Step 3. Add End Users to the Scanner

With the software installed and scanner configured for your network, you can now
add end users. At least one end user is needed for the scanner to work.

1 Within HP ScanJet 4Si Administrative Software, select the scanner where you want
to add users.

2 Select the Scanner menu.
3 Choose Add Users.
4 Highlight a user(s) in the Available Users list, which comes from the NetWare users

list.
5 Click <<Add to move the selected user(s) to the Available Users list.

N o t e If you have NetWare 3.x and you choose to display full names on the scanner’s
control panel, HP ScanJet 4Si Administrative Software will prompt you to input a
full name for any selected user who does not already have one.

6 Repeat steps 4 and 5 until all needed users have been added to the Available Users
list.

N o t e For options when adding end users and setting default properties, see the
Configurations Options section in this chapter.
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Step 4. Install the End User Software

End users will perform the following procedure from their systems to enable them
to use the scanner.  This procedure will install the Visioneer PaperPort Software and
the HP ScanJet 4Si Utility.

The directory that the user specifies in Step 3 must be defined by the network
administrator. The network administrator will also define if the installation will
allow users to run program from a local directory (Standalone) or from a shared
directory (Workstation).

1 Within Windows, select the File menu from Program Manager.
2 Choose Run.
3 Type the path where the software is installed followed by SETUP.EXE.   For

example, X:\HPSSCAN\CLIENTSW\SETUP4SI\DISK1\SETUP.EXE.
4 Press [Enter].
5 Follow the instructions on the screen.

This procedure must be repeated for each end user client.

N o t e Users must have a drive mapped onto the network server’s volume where the end
users’ software install program has been placed. (Refer to Step 1. Install the Scanner
Software.)

If trustees have not been granted to users in the installation procedure (refer to Step
1, “Install the Scanner Software”), the users will not be able to find and run the
users’ software setup program.

Directory structure for client PCs.

Figure 2-8
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How the software changes configuration files
Installing the scanner software causes the following changes to the user’s
configuration files.  Information in  italics is for the shared installation.

WIN.INI:
run=c:\paprport\runppdrv.exe
run = x:\hpsscan\clientsw\share4si\runppdrv.exe

N o t e This sets up a driver.  The driver tries to load ssnet.dll, which, in turn, polls the file
server for a network scanner. If it doesn’t find the scanner, it doesn’t report anything.

SYSTEM.INI
[driver]
paprport= c:\paprport\pportdrv.drv
paprport= x:\hpsscan\clientsw\share4si\pportdrv.drv

[ssnet]
ssnetapi_path = c:\paprport\util4si\ssnetapi.dll
nsu - executable_path= c:\paprport\util4si\nsuapp.exe
ssnetapi_path =
x:\hpsscan\clientsw\share4si\util4si\ssnetapi.dll
nsu - executable_path=
x:\hpsscan\clientsw\share4si\util4si\nsuapp.exe

The PPORTDRV.INI file is documented in the README.TXT file.
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Step 5: Selecting Configuration Options

In addition to the previous installation steps, the HP ScanJet 4Si scanner has several
configuration options.  Review the following options to decide if you want to use
them or if scanner’s default settings are appropriate for your network and end users.

Scan to Print (Enable Copying Functionality)

The HP ScanJet 4Si scanner can be configured so that documents are copied from
the scanner on a PCL5-compatible (or above) network printer. The print queue
names associated to the network printer will appear on the control panel as the
documents are scanned.

To enable copying for scan to print
1 Within HP ScanJet 4Si Administrative Software, highlight the desired scanner.
2 Select the Scanner menu.
3 Choose Add Printers.

N o t e If both the lists are empty, no print queues have been defined on the server.

4 Highlight the print queue(s) you want to use in the Available Queues list.
5 Click <<Add.
6 Click OK.

N o t e You can set printer parameters by clicking Setup when you have a print queue
highlighted.  This action will allow you to select the type of printer that is associated
with the print queue and set print parameters that will increase the copy quality.  See
Chapter 4, “Effects on Networks” for more information on copying functionality
(scan to print).
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Change End User Default Properties

You can redefine or override the default properties for the users on a server. 

This set of properties (related to work area and custom settings) will be assigned to
all new users added to a scanner on the selected server. 

N o t e You can override default properties for an individual end user by highlighting the
user name and clicking Properties on the Users Setup window.

1 Within HP ScanJet 4Si Administrative Software select the Server menu.
2 Choose Default User Properties. 
3 Select a work area volume name. This setting allows you to designate where the

scanned files will reside on the current file server for all new end users (default is
the volume 0).

4 Enter a number up to 16 in the Maximum Number of Custom Settings box. This
setting allows each user to define up to 16 configurations of scanner settings
(default is 5).

5 Select the default preferred scanner setting.  The software uses each grouped setting
of scanner parameters to obtain the best results for a given type of scanning. 

6 Click OK.

Override End User Default Properties

The Properties window allows you to override the default properties for a selected
user.

1 Within HP ScanJet 4Si Administrative Software select the Scanner menu.
2 Choose Add Users.
3 Highlight the desired user name in the Current Users List.
4 Click Properties.
5 Select a work area volume name. This setting allows you to designate where the

scanned files will reside on the current file server.
6 Select a preferred scanner setting from the preferred setting box.  The settings listed

will be the system settings available on the current server.  Custom settings can be
used only by the HP ScanJet 4Si Utility.

7 Enter a number up to 16 in the Maximum Number of Custom Settings box. This
setting allows the user to define up to 16 configurations of scanner settings.

8 Checking the Work Area Locked box will prevent any documents that are scanned
on the designated scanner to be sent to this specified user. The default is unlocked.
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Create Common Scanner Settings

You can create a system set of scanner settings to optimize the kinds of jobs that
users will be doing.  These settings will be the default used for all new scanner users
on the selected server.  The HP ScanJet 4Si Administrative Software program has
three predetermined settings:

•• Best Text 
•• Best Text & Photo 
•• Best Photo

To add new scanner settings
1 Within HP ScanJet 4Si Administrative Software, choose Settings from the Server

menu. 
2 Select the file server from the Server Selection list.  By clicking Connect you can

add or remove servers from the Server Selection list
3 When you have selected the server(s) desired, click Add.
4 Click OK.
5 Enter the name for the configuration in the Setting Name field.
6 Select settings for the following fields: resolution, scaling, intensity, contrast, output

data type, dither pattern, and background (optional).  See the User’s Guide for
definitions of each field.

7 Select the paper size setting. You may select Control Panel Select or Custom from
the control panel. If you select Custom you must enter its height and width. 

8 Click OK.

N o t e In the future you can copy any newly distributed configuration setting by clicking
Copy and entering a path and filename that contains the configuration settings.
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Introduction

This chapter explains how users operate and interact with the HP ScanJet 4Si
scanner.  The following topics are discussed:

•• Scanner usage model
•• Using the scanner control panel
•• Using the HP ScanJet 4Si Utility
•• Using the HP ScanJet Administrative Software
•• Using the PaperPort software and its links
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Scanner Usage Model

How a user operates and interacts with the HP ScanJet 4Si scanner is considerably
different than traditional scanners. The following steps describe the general process
from start to finish.  The user:

1 Checks the HP ScanJet 4Si Utility traffic light to see if the scanner is available.
2 Goes to the scanner and loads document in the ADF.
3 Selects his/her user name from the control panel. 
4 Presses the Start button. The document is scanned through the ADF to the Paper

Output Slot.  The user collects the originals. The scanned information is sent to the
selected user’s desktop.

5 Returns to computer, where the scanned information will appear as an untitled
thumbnail on the PaperPort desktop.

6 Uses Drag & Drop via PaperPort links to move the scanned information to the
desired application.

Note the features described in this process that are different from traditional scanners:

•• Traffic Light —This convenient feature of the HP ScanJet 4Si Utility allows users
to see if the scanner is available before they leave their desks to scan their
documents.

•• Scanning Process—The user begins scanning the document at the scanner rather
than computer software.  The interaction with the scanner itself is as simple as
selecting the recipient, pressing the Start button, and collecting the originals.  The
scanned items are sent to the user’s computer over the network.

•• Simple Document Manipulation—Scanned items can be manipulated easily and
quickly using the PaperPort software and, using Drag & Drop, can be sent to other
applications, such as word processing, fax, and e-mail applications.

Convenience Copy Usage Model
The following steps describe the general convenience copy process from start to
finish.  The user:

1 Checks the HP ScanJet 4Si Utility traffic light to see if the scanner is available.
2 Goes to the scanner and loads document in the ADF.
3 Presses Menu to selects the print queue from the control panel. 
4 Presses Menu again to select the number of copies by using the scroll keys (< or >).
5 Presses the Start button. The document is scanned through the ADF to the Paper

Output Slot.  The user collects the originals. The scanned information is sent to the
selected printer.

6 Goes to printer to retrieve the copies.

N o t e Print queues are added at the end of the list of users—use the scroll back (<) key for
fast access to selecting the print queues (Step 3 above).  You cannot copy a
document in duplex mode.
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Using the Control Panel

To scan a document into PaperPort’s desktop, you need to tell the scanner through
its control panel where you want your document to be sent:

1 With the control panel display reading Ready: Press Menu to select
destination , press the Menu key. The first destination (users or printers) on the
alphabetical list will appear.

2 Scroll through the destination list by pressing the < or > key until the desired
destination is displayed.  The message CURRENT USER: or CURRENT
PRINTER:  followed by the selected destination will appear.

3 Press the Start button to begin scanning.

Control Panel Tips

•• Hold down the < or > key to move through the destination list rapidly.
•• The preferred scanner setting at the destination selected will be used automatically.

To use a different scanner setting, press the Menu key.  The first setting (or
preferred setting, if defined) will appear.  Scroll through the list of available settings
using the < or > key.  The new setting will appear on the control panel display.

•• To stop scanning and save all of your data, press the Stop key.
•• To stop scanning without saving your data, press the Abort key.
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Using the HP ScanJet 4Si Utility

The HP ScanJet 4Si Utility is a tool you can use to monitor your networked
scanner and customize your settings based on the items you scan most frequently.
Using this utility, you can create your own custom settings by selecting resolution,
scaling, contrast, and other variables to get the best quality product from whatever
you’re scanning.

•• Monitor your networked scanner’s status
•• Lock or unlock your workarea
•• Change your scanning preferences

HP has provided standard system settings already configured to scan photos, text,
or text with photos.  In addition to these, your system administrator may have
created other system settings that are available for all HP ScanJet 4Si workgroup
users.

 You can start the HP ScanJet 4Si utility in several ways:

•• Start PaperPort, and the utility starts automatically.
•• Click the HP ScanJet 4Si Utility button on the PaperPort Command Bar. 
•• Double-click on the icon for the HP ScanJet 4Si Utility.
•• Select the Run command from the File menu in Program Manager.
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Using the Tool Bar

With the Tool Bar, you can select the following commands:

Scanner Status
Use this button to
check the status of
the current
network scanner
you are monitoring
or to select a
different scanner
to monitor.

Workarea Lock
Use this button to
lock or unlock your
workarea.  This
prevents others
from sending or
saving data  to
your workarea.
You can also clear
the data in your
workarea using
this button.

Scanner Settings
Use this button to
select system
settings, modify
existing custom
settings, and
create custom
settings.  

Help 
Use this button to
start the help
program.

Exit
Use this button to
exit HP ScanJet
4Si Utility.
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To monitor scanner status:
1 Click the Scanner Status button on the Menu bar or select Scanner Monitor from

the View menu.   The Scanner Status Dialog box will appear.

2 Select the scanner you wish to monitor.
3 Click Save or double-click the scanner name.

N o t e When you return to the main window, the Status Bar will display the name of the
scanner you’ve just selected and its status.

To lock or unlock your workarea:
Locking your workarea prevents anyone, including you, from scanning and saving
documents to your workstation.  The dialog box has two buttons to “toggle” your
workarea status between locked and unlocked.  Choose once to select; choose
again to de-select. 

1 Click on the Scanner Status button on the Tool Bar or select  WorkArea Lock
from the View menu. The WorkArea Lock dialog box will appear.

2 Click the button next to WorkArea Lock/Unlock to select whether you want to
lock or unlock your workarea.

3 Click OK to exit the dialog box.

N o t e Use the Clear Workarea feature when your workarea is locked, but documents have
been scanned to your workarea.  This feature will remove all of the documents that
are currently in your workarea so that they will never be loaded into the HP ScanJet
4Si desktop.  If you select Clear Workarea, any items scanned to your workarea will
be deleted; you will not be able to recover the scanned items.
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Changing Scanning Preferences:

HP ScanJet 4Si Utility allows you to change your scanning preferences by selecting
a system setting, creating a custom setting, or modifying a custom setting. The
scanner comes with three preset settings:

•• Best Text
•• Best Photo  
•• Best Text & Photo

When you choose to create a custom setting, you can specify resolution, scaling,
and other options. You can set a preferred setting, and that setting will automatically
be used when you begin scanning.
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To select a preferred setting: 
1 Click the Scanner Settings button on the Tool Bar or select View, Scanner

Settings from the View menu. 
2 Click on the setting you would like to use to select it.
3 Click OK to select a setting or click “Set Preferred” to select a setting as your

default setting.

N o t e When you select a preferred setting, this setting will automatically appear as your
default setting at the control panel.  A (P) will appear beside the setting on the
control panel.

To create a custom setting:
1 Click the Scanner Settings button on the Tool Bar or select View, Scanner

Settings from the View menu.
2 Click the New button in the Scanner Settings Dialog Box.  The Scanner Settings

Values Dialog Box will appear.
3 Enter a name for your custom setting.
4 Enter the custom settings you would like.
5 Click OK to save your new setting.
6 When you return to the Scanner Settings Dialog box, OK to return to the Main

window.

Your custom setting is added to the list of available settings. 

N o t e There are a maximum number of custom settings you can create. Your system
administrator has determined this number.  You can see this number in the “Scanner
Settings” dialog box next to “Total custom settings.” If your “Available Custom
Settings” line says 0, you will not be able to create a new setting without replacing
or removing an existing setting. You can’t replace or remove a system setting.
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Custom Settings Available

Setting Description

Setting Name Contains name of the setting.  If this is a new setting, the
phrase “Untitled” will appear in this box.  If you are editing
an existing setting, the name of the setting appears in this
box.  Enter a name up to 20 characters long.

Resolution Select the resolution by using this scroll bar.  You may select
from 12 to 1500 dots per inch (dpi).  The greater the number
of dpi, the greater amount of detail will be visible.  The
default value is 300. Do not use more resolution than
necessary.  Extra resolution does not add more detail and
takes up more disk space. 

Scaling The scaling range available is based on the resolution you
have selected.  Scaling reduces or increases the physical
size of your image.  The default value is 100.

Intensity Contains the intensity value.  This can vary from 0 to 255.
The default value is 128.

Contrast Contains the contrast value.   This can vary from 0 to 255.
Low contrast number values are mostly grays, while high
contrast number values are stark blacks and whites.  The
default value is 128.

Output Data Type Select two boxes.  The top box has four values: Black &
White 1bit, Dithered, Grayscale 4bit, and Grayscale 8bit.
Choose one of these to modify the number of bits for pixels.
The menu in the second box is only enabled if you select
Dithered in the top box.  If you have selected Dithered,
select among: Coarse Fatting, Fine Fatting, Bayer Dither,
and Vertical Line. The default for Output Data Type is Black
& White.

Background
Control

Select whether or not you would like background control.
Default is “off.”

Paper Size Select either control panel or custom.  “Control Panel”
settings are selected at the scanner control panel.  The
options are A4, Legal, or Letter.  “Custom” settings are user
defined within the following ranges:  width 0.0042 - 8.5
inches (0.01058 - 21.578 centimeters) and height 0.0042  -
14 inches (0.01058 - 35.541 centimeters).

N o t e If you choose the same name as an existing custom setting, HP ScanJet 4Si Utility
will  warn you. You may either click OK to continue and overwrite the old setting or
click Cancel to return to the dialog box and modify the setting name.
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To edit an existing setting:
1 Click the Scanner Settings button on the Tool Bar or select View, Scanner

Settings from the View menu.
2 Select the scanner setting you would like to modify.
3 Click Edit. The Scanner Settings Values dialog box will contain the name and

preferences of  your selected setting. 
4 Change the name of the existing setting to avoid replacing that setting. Leave the

name the same, if you want to replace the settings permanently.
5 Edit any of the settings you wish to change.
6 Click OK to save your new setting.
7 When you return to the Scanner Settings Values dialog box, click OK to return to

the Main window or click Cancel to leave values unchanged.

N o t e If you choose the same name as an existing custom setting, HP ScanJet 4Si Utility
will warn you that you can either overwrite the settings with the new values or abort
the operation.  To do this, click OK to continue and overwrite the old setting or click
Cancel to return to the dialog box and modify the setting name.

To remove a custom setting:
If you no longer use one of the existing custom settings or you would like to save a
new custom setting but have reached the total number of custom settings your
system administrator allows you, you can remove an existing custom setting.

1 Open the Scanner Settings dialog box by double-clicking the Scanner Settings
button on the Tool Bar or select View, Scanner Settings from the View menu.

2 Select the scanner setting you would like to remove from the Scanner Settings
Dialog Box.

3 Click the Remove button.
4 When you return to the Scanner Settings Dialog box, click OK to return to the

Main window.

N o t e You cannot remove a system setting.
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Using the HP ScanJet 4Si Administrative Software

The HP ScanJet 4Si Administrative Software shows the most important information
related to all the network scanners configured on the network.  If a scanner does not
appear on this screen, it means that the software cannot receive Service Advertising
Protocol (SAP) messages from the scanner (for example, the scanner might be
powered off or configured incorrectly).  To use this software, you must be logged in
with Supervisor privileges.

In the illustration, the HP ScanJet 4Si Administrative software shows the following
information:

•• Name—the logical name of the scanner.  Unconfigured is displayed for new
scanners or when the network box has been replaced.

•• Network—the network address.
•• Address—the HP ScanJet 4Si media access control (MAC) address.
•• Server—the name of the NetWare file server where the HP ScanJet 4Si is

configured.
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HP ScanJet 4Si Administrative Software—Menu Items

The HP ScanJet 4Si Administrative Software can also provide the following
information or allow you to perform the following actions:

Scanner Menu

•• Configure
•• Add Users
•• Add Printers
•• Status
•• Unconfigure
•• Reset

Choosing Status on the Scanner menu will show scanner and server name,
model, availability, and frame type.
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Server Menu

•• Connect
•• Settings
•• Default User Properties
•• Cleanup (of unrecognized files)

Choosing Settings from the Server menu allows various adjustments to
scanning and paper size values.

View Menu

•• Filter (allows list of network scanners to be filtered by one or more criteria)
•• Sort (by name, server, network number, or address)
•• Refresh
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Using the PaperPort Software and Links 

Links let you process or send PaperPort items without leaving PaperPort.
PaperPort automatically displays link icons for your printer, and the applications it
supports, including word processing and spreadsheet applications, electronic fax,
e-mail, and graphics, and optical character recognition (OCR) applications.

PaperPort Links 

See the table below for applications that PaperPort can detect automatically.

E-Mail
Applications

Groupware 
Applications

Word Processing
Applications

Fax Applications OCR
Applications*

Graphics and
Additional

Applications

Lotus cc: Mail v 2.0/later
Microsoft Mail v 3.2/later
DaVinci Mail v 2.5
(v 3.0 is not supported)

Lotus Notes v 3.0c/later
Novell GroupWise v 4.1
WordPerfect Office 4.0a

Microsoft Word  2.0/later
WordPerfect v 6.0/later
Lotus AmiPro v 3.1/later
Microsoft Write v 3.11

Delrina WinFax 4.0/later
Trio Datafax v 1.0
Phoenix Eclipse FAX v 6.0
WordStar/ZSoft Ultrafax
v 1.0/later
Any fax application that works
as a Windows print driver**

Caere OmniPage Pro
v 5.0/later
Caere OmniPage Direct
v 1.0/later
Calera WordScan Plus
v 3.0/later
Calera WordScan 
v 3.0/later

Corel PhotoPaint
(bundled with Corel
Draw)

*   If you experience problems when using OCR links, make sure you have at least 8 MB of RAM available, 4 MB Windows swap file, and enough disk space to create
    temporary word processing files.
** You could experience poor image quality when sending grayscale images with the following fax links: Intel FaxAbility v 1.0/later, Caere FaxMaster v 1.01/later, 
    and Intel Proshare v 1.5/later.  Try converting the image to black and white before faxing or scan the image directly as black and white rather than grayscale.

N o t e PaperPort links can be added for many more application links than are listed here,
provided that an application link file (.glk) is available for your favorite application.
To find out what application links are supported and how to obtain a link file, refer
to the “Links” section of the HP ScanJet 4Si scanner README file.  To open this
file, double-click on the “HP ScanJet 4Si README - User” icon in the PaperPort
group in the Program Manager.

EN Operation and Use 3-15



Types of Links

•• Printer —Use this icon to print items instead of choosing the Print command from
the File menu.

•• E-mail—Use the e-mail icon to send a PaperPort item as an attachment to an e-mail
message. The Link Bar displays an e-mail icon for each e-mail application installed
on your computer that works with PaperPort.

•• Word Processor—The word processor icon shows which word-processing
application will receive text from PaperPort after the text is converted by your OCR
application. If you also have another supported OCR application on your computer,
PaperPort will create an additional link icon for it. You can then read text directly
into that application using drag-and-drop techniques. 

•• Spreadsheet —The spreadsheet icon displays the spreadsheet selected for the OCR
software provided with PaperPort. Use this link when you want to convert a
scanned spreadsheet into editable numbers and text.  Like the word processor link,
this link will process a item, convert its image text and numbers into editable text
and numbers, and then open it in the selected spreadsheet application.  In most
cases, the column-by-column layout of the scanned spreadsheet will be retained.

•• OCR—If another OCR application, such as Caere OmniPage Limited Edition (LE),
is installed on you computer, its icon will also appear on the Link Bar.  When you
use this OCR link, the file is converted to a TIFF file, and processed by that OCR
application.  If you install other supported OCR applications, PaperPort
automatically adds those icons to the Link Bar. 

•• Electronic Fax—The fax icon shows which fax application PaperPort will use to
send items. If you are using one of the fax applications supported by PaperPort,
shown in the table on the previous page, its icon will appear automatically. If you
are using another fax application, the icon will be a generic fax icon as shown in the
sample above. You can then select your fax application in the PaperPort
Preferences dialog box.

•• Graphics (and other applications)—This is a sample of an additional link icon
that will be added to your PaperPort Link Bar. Other links include Adobe
Photoshop 2.5 and 3.0 and KidPix.

T i p  For information about selecting the scanning options that will give the best results
for items that you want to send as e-mail, fax, or process with your OCR software,
see the User’s Guide, Chapter 4, “Setting Scanner Preferences.”

N o t e Many applications can also become PaperPort links.  For details, see the section,
“Setting Preferences for the Links,” later in this chapter.
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Basic Steps for Using Links 

The steps for using links are similar each time you use a link:

1 Scan items into PaperPort. 
2 Drag and drop items onto the appropriate link icon in the Link Bar, or choose Links

from the File menu and select the appropriate link application from the Links
submenu. You can also select the item(s) and just click on the link icon.

3 Use the linked application as you normally do. For example, if you’re sending a
item using an electronic fax link, address the electronic fax and send it.

N o t e  Some applications limit the number of pages that can be received from the
PaperPort link. If you have trouble with large stacks of pages, try sending the pages
in smaller batches.
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Printing Link

You can print from both Page View and Desktop View. PaperPort can print in
black-and-white and grayscale.  

To print a Item: 
1 In Desktop View, select the item to print. If you’re looking at the item in the Page

View, you do not have to select it.
2 In Desktop View, drag and drop the item onto the Printer icon on the Link Bar, or

just click the Printer icon.  From the File menu, choose Print. The Print dialog box
appears so you can select the print options.

3 Click OK to begin printing.

N o t e If you have deselected the Display Print Dialog option in the PaperPort Preferences
dialog box, printing starts immediately.

N o t e If the item has annotations that you don’t want on the printed copy, display the item
in Page View; then remove the checkmark next to the Show Annotations command
on the Annotations menu. Choosing the command removes the checkmark. 

Print Option Description

Print to Range All  prints all pages in the selected item. If you’re printing
a stack, prints all pages in the stack.  
Pages  prints a range of pages from the selected stack.
Enter the pages to print From and To.

Print to File Select this option to print pages to a file instead of to
the printer. When you click OK a dialog box appears so
that you can designate the file to receive the printed
pages.

Copies Type the number of copies to print.

Collate Copies Click to print the copies as collated items. For example,
if you’re printing three copies of a three-page stack, the
pages will be printed 123, 123, 123 if you select Collate
Copies, and 111, 222, 333 if you do not.
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E-Mail Link 

You can send a item from PaperPort using your e-mail application. For example,
you can mail scanned memos, budgets, newspaper clippings, photographs, and
spreadsheets as attachments to your e-mail message. 

To send items using e-mail: 
1 On the PaperPort Desktop, select the item(s) you want to send. 
2 Drag and drop the item onto the e-mail icon in the Link Bar, or from the File menu,

choose Links, then choose the e-mail application name from the Links submenu. 
3 Open your e-mail application. 
4 Fill in the message information, and send the message.

PaperPort creates a file and attaches the item to an e-mail message. The file has the
extension .MAX, for example, DOC-0001.MAX. If the item is a single page, the
file name begins with PAGE and is followed by the item’s number, for example,
PAGE0002.MAX. 

N o t e If you want to send someone a PaperPort item who doesn’t currently have
PaperPort, you can attach the PaperPort Viewer.  However, the PaperPort Viewer is
able to display .MAX 2.0 files only.  If you are using a later version of PaperPort,
save the item in .MAX 2.0 format before sending it.  For more information, see
“PaperPort Viewers” later in this chapter.

Using PaperPort with cc:Mail 
If you use cc:Mail to send messages, a set of familiar dialog boxes will appear
when you use the e-mail link from PaperPort.

To send a cc:Mail message
1 Drag the item from the PaperPort Desktop onto the cc:Mail icon on the Link Bar.
2 In the Login dialog box that appears, enter the name and password that you

normally use to login to your cc:Mail account.
3 Click OK.  The remaining dialog boxes that appear offer the standard cc:Mail

options, including access to your private post office addresses and internet
addresses.  However, access to bulletin boards must be through the cc:Mail
application itself.

4 When you send the message, the PaperPort item is sent as an attachment to the
message. 
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To display e-mail messages sent from PaperPort 
When you receive an e-mail message with an attached PaperPort file, you can view
the e-mail message and the attached file. You can display an attached file in
different ways, depending on your e-mail software:

•• With some e-mail applications, such as Lotus cc:Mail, you can double-click the
attachment to display it.

•• With some e-mail applications, use Shift-double-click to automatically run the
PaperPort application and display the attachment. 

•• Save the attached file by using the e-mail Save or Save As command, then opening
the attachment in PaperPort to display it. 

3 - 20 Operation and Use EN



Word Processor Link

A scanned item is an image, and you cannot edit its text. However, you can use
PaperPort with optical character recognition (OCR) software to process a scanned
image.  The OCR software converts the scanned text image to editable text; it does
not translate photos or graphics.  You can process an entire item, or only the text
that you select.  You have several options for using OCR software with PaperPort:

•• PaperPort OCR software—Use the word-processing or spreadsheet icons on the
Link Bar.  The text is processed by the OCR software provided with PaperPort and
then opened in you selected word-processing or spreadsheet application

•• OCR software link—If you have other OCR software on your computer you can
use it to process the text. Use that OCR’s icon on the Link Bar.  That OCR
application opens and displays the converted text.

•• Copy As Text command—You can select text, or an entire PaperPort item, copy it
as text, and paste it in some other application. During copying, the OCR software
automatically converts the image into text.  When you paste the text into another
application, it is editable text.
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OCR Links

Use the following steps to process text using either the PaperPort OCR software or
with other OCR software.

To process text using the PaperPort OCR link: 
1 On the PaperPort Desktop, select an item.
2 Drag and drop the item onto the Word Processing icon in the Link Bar, or from the

File menu, choose Links, then choose OCR from the submenu.

The OCR software converts the item to editable text, then the word-processing
application opens and the converted text is an untitled file waiting to be saved as a
word-processing file. You can now edit the text as you normally would with that
application.

To process text using another OCR link:
1 On the PaperPort Desktop, select an item.
2 Drag and drop the item onto that OCR icon on the Link Bar, or from the File menu

choose Links, then choose the name of the OCR software from the submenu.  The
file will be converted to a TIFF file and processed by the OCR software.

To process text using the Copy As Text commands:
1 If you want to process an entire item, select it on the Desktop.
2 From the Edit menu, choose Copy As Text.  PaperPort processes the text with the

OCR software and places the now-editable text onto the Clipboard.  You can then
paste the text into another application, such as a word processor.

N o t e If you want to process only a portion of a page, display it in Page View, click the
Selection button on the Annotation Tool Bar, and select the portion of text that you
want.
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Electronic Fax Link

You can scan a item to the PaperPort Desktop, add annotations, and send the item
as an electronic fax using your fax application.  Your computer must have access to
a fax modem and electronic fax software to send a fax from PaperPort.

To send items using the fax link:  
1 On the Desktop, select the item(s) you want to fax. If you don’t want PaperPort

annotations to appear in the faxed item, uncheck the Show Annotations option from
the Annotations menu.

2 Drag the item onto the Fax icon in the Link Bar, or choose Links from the File
menu, then choose the fax name from the submenu.  To send a fax from Page View,
use the Links command on the File menu.

3 Use your electronic fax application as you normally do.

To read a WinFax fax in PaperPort:
1 From the File menu, choose Import Fax. The Import Fax dialog box appears and

lists the faxed items available to be read in PaperPort.
2 Select one of the faxed items in the list. A thumbnail of it appears in the dialog box.
3 Find the faxed items to read and select them, or to read all of the faxed items, click

Select All.
4 Click Import.

The selected faxed items appear on the PaperPort Desktop. You can now select
them there and switch to Page View to read the fax.
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Setting Preferences for Links

Each link icon on the Link Bar has a set of preferences for customizing the way the
link operates.

To set preferences for the Links: 
1 From the Edit menu, choose PaperPort Preferences.  The PaperPort Preferences

dialog box appears.
2 The category list shows the Link icons.  Use the scroll bar to see the icons on the list.
3 In the Category list, click the icon of the link you want to customize. For example,

to set preferences for your fax software, click its Fax icon. The options in the
Preferences dialog box will apply to the icon you clicked.

4 Select the options for the link.  Click OK.

N o t e Use the generic fax and word processor links to specify applications that are not
automatically supported by PaperPort.  The generic links are “wildcard” icons that
you can use to specify links to other fax applications or  word processor to use with
the PaperPort OCR software.  To use one of these links, click on it and assign the
desired application’s .EXE file to it.
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PaperPort Link Preferences 

The options available in the PaperPort Preferences dialog box depend on the
applications that are on your computer.  For that reason, some of your PaperPort
preferences may differ from those shown in the following table.

Link Icon Option Description

All that appear on the
Link Bar

Display Link Icon Select to see the icon on the Link Bar on the PaperPort Desktop.  If this
option is not selected, the icon does not appear, but you will still be able to
use the link by choosing from the Link submenu in the File menu.

Printer Collate Copies Prints multiple copies with pages of each copy in sequence.

Automatic Page
Orientation

Changes the page orientation of the printer to match the selected item’s
page orientation.

Display Print Dialog Displays the Print dialog box before the item is printed. If this option is not
selected, the dialog box does not appear.

E-mail File Format to Use Select the file format the item is saved as when it is attached to an e-mail
message. The available formats may include PaperPort (.MAX versions
2.0 and earlier and version 3.0), the e-mail application’s format, Windows
Bitmap (.BMP), Windows Paintbrush (.PCX), Multi-page PCX (.DCX), and
several TIFF formats. If you choose PaperPort, the recipient must have
PaperPort or PaperPort Viewer installed to read the attached PaperPort
file. If you know that the recipient only has the PaperPort viewer, you need
to save the files as .MAX version 2.0 or earlier.  Otherwise, the viewer will
not be able to read the file.

Save Password Select this option if you want PaperPort to require the password before it
starts the e-mail application. If you save your password, PaperPort
bypasses the Login dialog box. Not all e-mail links support this preference.

Receipt Select for a return receipt when the e-mail message is received and
opened by a recipient.

Log Select if you want a copy of the message to be put into the user’s log.
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Link Icon Option Description

Word Processor,
Spreadsheet, Copy As
Text, and Generic
Word Processor

Word Processor
Application

Use this option to select the application to receive the converted text from
the OCR software.  For example, to send the converted text to NotePad,
enter the full path name of the NotePad application file.  (It will have an
.EXE extension.)  The application does not have to be a word processor;
you can also set this link to send converted text to a spreadsheet.

Browse. Use this button to select the application file (.EXE) for the OCR link.  A
dialog box appears, and you can find and select the .EXE file.  When you
select the file and click OK on that dialog box, the full path name is
entered in the Word Processor Application field.

Item Format Click on the drop-down arrow and choose the format for the converted
text.  PaperPort will automatically choose the right format for the word
processor that is already selected.  You can also choose other formats,
such as ASCII, for special situations.  The format must be supported by
both  the OCR software and the word processor application.

OCR Package Use this option if you have another OCR software package on your
computer and want to assign it to the word-processor link on the Link Bar.
Click on the drop-down arrow and choose the OCR package from the list.

OCR Settings Click to see special settings for the OCR software package you selected.
Two typical options are (these pertain to Word 6.0):
Automatic Page Orientation—PaperPort determines if the page is in
portrait or landscape mode and will send it in that mode.
Decolumnized Output—Organizes the text in a single format, even if the
original item has multiple columns, such as a newspaper article. (Test this
setting to see if it works for your scanned items.)

Fax and Generic Fax Automatic Page
orientation

PaperPort determines if the page is in portrait or landscape mode and will
send it in that mode.

Setup Displays a dialog box for additional fax setup options, such as page size
and orientation.  The options depend on the fax application.

Generic Fax Only Select a Fax Driver Use this option to assign a fax driver to your generic electronic fax
application (one that PaperPort does not configure automatically).
PaperPort will add that fax icon to the Link Bar.

Graphics and
additional OCR

File Format to Use Select the file format in which to save the graphic item.  The options will be
Windows graphic formats, such as .BMP and .PCX.

Replace Desktop Item
if Modified

If you make changes to the image in the graphics application and then
save it, the modified image replaces the original one on the PaperPort
Desktop.

Show Annotation
Warning

If selected, a warning message appears when you drag an image onto the
graphics link reminding you that if you make any changes to the image in
the graphics application, and then save it, all annotations made to the item
in PaperPort are deleted from the item.
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PaperPort Viewers

The PaperPort Viewer lets you share PaperPort items with others who do not own
PaperPort software.  With PaperPort Viewer, others can view and print PaperPort
items. 

N o t e If you use PaperPort 3.0 and send an item to someone else to view using the
PaperPort Viewer, save the item in a .MAX 2.0 format.  Others will not be able to
view your PaperPort 3.0 files. 

Obtaining Copies of PaperPort Viewer 

PaperPort Viewer for Windows comes with the software on separate disks.  You can
distribute PaperPort Viewers to others free of charge. PaperPort Viewers are also
available free on CompuServe.  Others can log on to CompuServe and retrieve the
PaperPort Viewer file.  To download the files, just type Go PaperPort  in the
Office Automation Forum.

Hardware and Software Requirements

•• Windows
•• IBM or 100%-compatible personal computer with a 386 microprocessor or higher
•• Windows 3.1 or later
•• 4 MB of memory
•• 1 MB of hard disk space
•• VGA monitor or better

•• Macintosh
•• Macintosh Plus or later model
•• System 6.0.4 or above
•• 2 MB of memory
•• 400 kilobytes (K) of hard disk space 
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Installing PaperPort Viewer

To Install the PaperPort Viewer for Windows
1 Start Windows.
2 Choose Run from the Program Manager File menu and enter the drive and path

information (for example, type N:\PAPRVIEW\PAPRVIEW.EXE in the Run box).
The first time you start a shared copy of PaperPort Viewer from a workstation, it
displays a message asking if you want to complete the workstation installation. 

3 Choose Install Viewer to complete the installation. A message indicates when the
workstation installation is complete. 

4 Click OK to close the message.

To install PaperPort Viewer for Macintosh: 
The PaperPort Viewer for Macintosh comes as a self-extracting archive file. You
should have the file PaperPort Viewer.sea on disk before starting. 

1 Display the Macintosh desktop. 
2 Insert the PaperPort Viewer for Macintosh disk into the floppy disk drive. 
3 Double-click the file PaperPort Viewer.sea. 
4 Click Continue. The directory dialog box appears. 
5 Select where you want to install PaperPort Viewer, then click OK to begin the

installation.
6 A message indicates when the PaperPort Viewer installation is completed. 
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Effects on Networks

No NLM Loaded on the NetWare Server

There is no scanner software module (no Network Loadable Module or “NLM”)
loaded on the server, which guarantees that the HP ScanJet 4Si scanner installation
will not jeopardize your server state.  The NetWare server is used only to store
temporary data in the user workareas, and to keep some general configuration files.
The network scanning system may be installed on different volumes of the server
disk.  In all cases, everything is saved under a directory called HPSSCAN.

Impact on Network Performance

The HP ScanJet 4Si acts as a common NetWare client personal computer that
transfers files to the server or prints to a network printer.  To achieve better transfer
performance and cause less impact on the overall network, data is compressed (G4
and Packbits) internally and then it is sent to the server.  The table below shows
approximate file sizes per page and compression schemes for the HP ScanJet
4Si-Server and Server-Client transactions:

Data Type File Size Compression

1-bit 30 KB G4

4-bit 1 MB Packbits

8-bit 8 MB None

Scanner-to-Desktop Data Conversion
When data is received at the client PC, PaperPort converts the compressed file to its
own format (.MAX), which allows full manipulation of the documents.

N o t e For information on how the scanner software changes your system configuration
files, see “Installing the Scanner Software: in Chapter 2.
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 New Object in the Bindery

Any HP ScanJet 4Si scanner installed will be a new object in the NetWare server
Bindery.  Its unique object number is 0x0815 (OT_NETWORK_SCANNER).  The
HP ScanJet 4Si Administrative Software will create, update, or delete
OT_NETWORK_SCANNER objects from the Bindery based on the task it is
processing. 

N o t e Do not use any Bindery administrative tool other than HP ScanJet Administrative
software to edit or delete the OT_NETWORK_SCANNER object because it will
damage your network scanner installation.

Service Advertising Protocol (SAP)

The HP ScanJet 4Si scanner uses SAP messages to notify the HP ScanJet 4Si
Administrative Software of its presence on the network.  A SAP message is sent
every 60 seconds and it is mainly used by HP ScanJet 4Si Administrative Software
to check the presence of new and old HP ScanJet 4Si scanners on the network. SAP
messages contain information about the scanner, as shown below. In order to have
the HP ScanJet 4Si Administrative Software working correctly, ensure that it can
receive SAP packets from the HP ScanJet 4Si scanner (same frame type). Do not
put any SAP filtering in between the software and scanner.

The scanner sends SAP packets with information about its presence on the network.

Figure 4-1
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Scan-to-Print (Copy Functionality)

Scan-to-Print (copy functionality) is implemented using the NetWare print queue
mechanism.  Before enabling copy functionality on an HP ScanJet 4Si scanner, the
network administrator has to create at least one print queue on the server using the
Novell PCONSOLE tool (NWADMIN on NetWare 4.x), and then he/she can use the
HP ScanJet 4Si Administrative Software to add the print queue as a special user of
the HP ScanJet 4Si scanner.  

Scan-to-print jobs are sent Packbits-compressed directly to the printer, which has to
be PCL 5-compatible.  The HP ScanJet 4Si scanner addresses the network printer as
any other NetWare client (it does not use SPX protocol).

Scan to Print performance varies based on job size, the number of copies, and the
kind of original item scanned.  Generally, the following performance can be
expected for text items:

•• 1 copy of 1 text page = 2 ppm
•• multiple copies of 1 text page = up to 14 ppm
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Introduction

This chapter discusses basic scanner maintenance procedures, explains scanner
control panel and software messages and errors, and recommends actions you can
take to correct problems. 

This chapter will help you with the following tasks:

•• Troubleshooting
•• If Your Scanner Isn’t Working
•• Clearing Paper Jams
•• Scanner Maintenance
•• Unconfiguring the Scanner
•• Resetting the Scanner
•• Replacing a Broken Scanner or Network Box

•• Error Messages
•• Control Panel Status and Error Messages
•• HP ScanJet 4Si Administrative Software Messages
•• HP ScanJet 4Si Utility Messages
•• Visioneer PaperPort Error Messages

•• Warranty and Service Information

If you have questions that are not answered in this chapter, see the “HP Service
Worldwide” section in Chapter 6 for information on contacting Hewlett-Packard
Service and Support.
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Troubleshooting

Scanner is Not Working

Make sure the following conditions are true:

•• The two power cords are connected securely to the scanner and network boxes, and
they are plugged into electrical outlets.

•• Scanner, ADF, and control panel are connected to the network box with the proper
cables.

•• Scanner and network box are turned on. 
•• Scanner is connected to the network.
•• Scanner is unlocked.

If these conditions are met and the scanner is still not working, turn the scanner and
network box off, wait 10 seconds, and 1) turn on the scanner on followed by 2) the
network box.

Scanned Image Quality is Poor

•• If scanned pages are blank, white, or have repeated patterns, make sure that a page
is not already on the scanner glass. Otherwise, see the Scanner Maintenance section
later in this chapter.
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Clearing Paper Jams

When you have a paper jam, the scanner control
panel displays an error directing you to where it
occurred: the start of a page, the end of a page, or
inside the ADF.  Use one of the procedures on the
following pages to remove the type of paper jam
you have.

Jams  at the start of a page

1 Open the ADF cover
2 Remove the jammed paper
3 Close the ADF cover securely.
4 The control panel will prompt you to do one

of the following actions by pressing the
corresponding key:

•• Reinsert the paper and continue scanning <l>
•• Stop scanning and save your data (\/)
•• Stop scanning without saving your data (//)
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Jams at the end of a page

1 Open the ADF cover, and lift up the document
tray.

2 Remove the jammed paper.
3 Close the document tray and the ADF cover

securely.
4 The control panel will prompt you to do one

of the following actions by pressing the
corresponding key:

•• Reinsert the paper and continue scanning <l>
•• Stop scanning and save your data (\/)
•• Stop scanning without saving your data (//)
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Jams inside the ADF

1 Open the ADF cover.
2 Lift up the ADF unit.
3 Open the delivery guide by grasping the small

plastic handles on either side of the delivery
guide and pulling down.

4 Remove the jammed paper.
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5 Close the delivery guide sheet by aligning its
holes with the small plastic spindles on the
delivery guide and pressing down.

6 Close the document tray and the ADF cover
securely.

7 The control panel will prompt you to do one
of the following actions by pressing the
corresponding key:

•• Reinsert the paper and continue scanning <l>
•• Stop scanning and save your data (\/)
•• Stop scanning without saving your data (//)
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Scanner Maintenance

Your HP ScanJet 4Si scanner requires occasional cleaning and regular maintenance
to produce the best results when scanning documents.  If you do not receive error
messages from your scanner software or the control panel but you notice problems
with the quality of your scanned documents, the following procedures may help.

The section will help you with the following tasks:

•• Cleaning the scanner
•• Replacing the delivery guide sheet
•• Replacing the lower roller
•• Cleaning up work area files

Cleaning the Scanner

C a u t i o n Always turn off the scanner and unplug all power cords before cleaning.

1 With a clean, soft cloth and a mild detergent, wipe off the outside of the scanner.
2 Dry the scanner with a clean, soft cloth.
3 Lift up the ADF
4 Open the delivery guide by grasping the small plastic handles on either side of the

delivery guide and pulling down.
5 Use a clean, soft, dry cloth, wipe the inside surface of the delivery guide sheet.
6 Close the delivery guide and wipe its outside surface with the cloth.

N o t e If your scanning quality is still poor after cleaning (vertical black lines, for
example), you will need to replace the delivery guide sheet.  See the procedure
below.  For ordering details, see “Replacement Parts and Accessories” later in this
chapter. 
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Replacing the Delivery Guide
Sheet

1 Lift up the ADF
2 Open the delivery guide by grasping the small

plastic handles on either side of the delivery
guide and pulling down.

3 Remove the used delivery guide sheet.
4 Install the new delivery guide sheet by

aligning its holes with the small plastic
spindles on the delivery guide and pressing
down.

N o t e  
Make sure that the free end of the clear guide is
tucked behind the white padded sheet.
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Replacing the Lower Roller

1 Lift up the ADF.
2 Press down on the plastic cover located behind

the right hand roller, and pull the cover
towards you.

3 Move the rollers to the right and remove the
rollers and roller bar.

4 Install the new lower rollers by inserting the
left side into the matching bar in the scanner .
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5 Replace the plastic cover, putting the bottom
feet in place first.
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Cleaning Up Work Area Files

Occasionally unwanted document files or stray pages of documents will be stored
on the server in the user’s work area. You can delete these files from the Cleanup
window in the HP ScanJet 4Si Administrative Software program.

1 Within HP ScanJet 4Si Administrative Software, select the Server menu.
2 Choose Cleanup.
3 Select the file server from the Server Selection list. You may add/remove servers

from the Server Selection list by clicking Connect.
4 Highlight any of the unrecognized files (for example, files with numbered

extensions, such as .000, .001.002, etc., or files with a .hps extension).
5 Click Delete to erase the files.
6 Click OK to exit.
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Unconfiguring and Resetting the Scanner

If you need to move your scanner from one network to another, or unconfigure the
scanner, the HP ScanJet 4Si Administrative Software gives you the option to
restore factory defaults and reconfigure the scanner.

Restoring Factory Defaults
To clear the scanner’s configuration settings and return to the factory defaults, use
the following procedure.  The scanner must be unconfigured with the special key
combination: 

1 Turn off the scanner.
2 Press the following control panel keys at the same time: PAPER SIZE, DUPLEX

and LEFT ARROW. 
3 Turn on the scanner.
4 Reinitialize the scanner using the HP ScanJet 4Si Administrative Software (see

procedure below).

Installing a Replacement Scanner 

Use the following steps when replacing a broken scanner or network box with a
new unit or after you have unconfigured a scanner and restored factory defaults.

1 Install the replacement unit.
2 Name the scanner in the HP ScanJet 4Si Administrative Software.  Use the same

name for the new unit as the one it replaced.

N o t e If you don’t remember the name of the unit being replaced, use the HP ScanJet 4Si
Utility software.

3 If the old name is used, all of the previous configuration information is recovered.
If a new name is used, all the users must be added again.
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Control Panel Messages

The HP ScanJet 4Si scanner control panel displays two types of messages: status
and error.  Scanner status messages tell you what is happening in various scanning
operations and usually require no action.

Scanner error messages may require actions such as checking to make sure your
scanner, associated software, or network is operating correctly. 

The scanner’s status and error messages are presented alphabetically in the
following tables.

Control PanelStatus/Error Messages

Control Panel Status/Error
Message

Description Recommended Action

A4 paper selected The document you have
selected to scan is on A4-size
paper.

No action needed.

Aborted! The user chose to stop the
scanning job without saving the
data.

No action needed.

Aborting... The user has chosen to abort
the current job. All pages that
have been scanned will be
erased.

No action needed.

Auto-resetting... The system is performing an
auto-resetting, which clears all
the previous selections.

No action needed.

Booting ScanJet 4Si The scanner is booting. No action needed.

Communication error (13) The control panel is working,
but there is something wrong
with the connection to the
network box.

1. Check if the cable connecting
the control panel with the
network box is plugged in.
2. If error persists: it is not clear
if the problem is in the control
panel or network box. The entire
unit should be exchanged.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Configuration error (70-71-72) 
ScanJet 4Si halted

The internal configuration
parameters are corrupted.

Reconfigure the scan station
(see “Resetting the Scanner” in
this chapter). 

Copies The number of copies selected
for the current job is shown next
to this prompt.

No action needed.

Copy error (111) Press any key... An error occurred while writing a
page into the queue.

To verify that the print queue
and printer are working, run
NetWare command
PCONSOLE to check the print
queue:
1. If it was deleted, create the
print queue again and assign it
to the scanner using HP
ScanJet 4Si Administrative
Software.  
2. If the print queue has not
been canceled, check if the
scanner name is entered in the
Q-USERS property.  If not, run
HP ScanJet 4Si Administrative
Software and assign the
scanner to the print queue. 
3. Check to see if the server
SYS volume (where print
queues are) is full.
Send a network print job to the
same print queue to see if it
prints out.

Copying page The scanner is copying a page. No action needed.

Cover opened! (209)
Please close it.

The ADF cover is open Close the cover.
If the problem persists, replace
the ADF and control panel
module.

Current application: The user has selected to scan
to the application shown next to
this prompt.

No action needed

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Current default paper: A message within the
configuration menus prompting
the system administrator to
select a default paper size.

Choose a default paper size;
see Chapter 2 for more
information on using the
configuration menus.

Current frame type: A message within the
configuration menus prompting
the system administrator to
select a frame type.

Choose a frame type; see
Chapter 2 for more information
on using the configuration
menus.

Current language: A message within the
configuration menus prompting
the system administrator to
select a display language.

Choose a display language; see
Chapter 2 for more information
on using the configuration
menus.

Current num. of copies The number that appears in the
next line is the current number
of copies selected.

No action needed.

Current printer: The print queue name on the
line below is the current
selection.

No action needed.

Current setting: Lists the current scanner
configuration available for the
selected destination.

No action needed.

Current Token Ring speed: A message within the
configuration menus prompting
the system administrator to
select a Token Ring speed.

Choose a Token Ring speed;
see Chapter 2 for more
information on using the
configuration menus.

Current user: The user on the line below is
the current selection.

No action needed.

Destination locked (108) Press
any key...

The user at that location has
locked the work area.
A workarea is locked even when
locking field is not found in the
private configuration file. 

1. Use HP ScanJet 4Si Utility to
unlock the work area. 
2. A lock is also generated when
the “Lock” field is not found in
the HPSSCAN\ USERS\
<workarea>\ CONFIGS.CFG
file. Check if lock field exists, 
3. If not: delete user with HP
ScanJet 4Si Administrative
Software, delete his/her
workarea and create the user
again.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Done! The scanner has completed the
scanning job.

No action needed.

Double-sided selected You have selected to scan a
two-sided (duplexed) document.

No action needed.

From: This message corresponds to
the message “To.”

No action needed.

Initializing...wait The control panel is working but
there is something wrong with
the connection to the network
box.

1. Ensure the cable connecting
the control panel with the network
box is properly plugged in.
2. If error persists: it is not clear
if the problem is in the control
panel or network box. The entire
unit should be exchanged.

Internal error (10) ScanJet 4Si
halted

Internal information on
temporary storage cannot be
accessed.

1. Power cycle the scanner.
2. If the problem persists,
replace the network box.

Internal error (11) ScanJet 4Si
halted

Internal memory error 1. Power cycle the scanner.
2. If the problem persists,
replace the network box.

Internal error (12) ScanJet 4Si
halted

Internal memory error If the error message shows up
just after booting, there are too
many destinations or print
queues defined. 
1. Run HP ScanJet 4Si
Administrative Software to
remove some of them from the
scanner configuration and reset
the network scanner.

If the error message shows up
when the GO key is pressed
for the selected destination, it
means that the destination has
too many settings defined,
which cannot be handled by the
network scanner. 
1. Execute the HP ScanJet 4Si
Utility software to remove some
settings and reset the network
scanner.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Internal error (14) ScanJet 4Si
halted

Internal error. Reboot the scanner.  If the error
persists, please report it to HP
Customer Service Center for
escalation.

Internal error (15) ScanJet 4Si
halted

Connection problem between
the scanner and network box.

Execute the following steps
1.  Turn off the scanner and
network box. 
2. Check the SCSI cable
between the scanner and the
network box.
3. Turn on the scanner and
network box.  If the problem
persists, replace the network
box.

Internal error (16) ScanJet 4Si
halted

Internal memory error Power cycle the scanner. If the
problem persists replace the
network box.

Internal error
(65-66) ScanJet 4Si halted

Internal memory error. Power cycle the scanner. If the
problem persists replace the
network box.

Internal error
(73) Press any key...

The internal information about
the localized messages for your
language cannot be accessed. 

Try reconfiguring the language.
If the error persists, the
language file is corrupted.
Replace the network box.

Internal error
(74) Press any key ...

The internal information about
the localized messages for your
language are corrupted.

Try reconfiguring the language.
If the error persists, the
language file is corrupted.
Replace the network box.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Internal error
(120) ScanJet 4Si halted

HP ScanJet 4Si scanner has
reached the maximum number
of destinations or configurations.

If the error message shows up
just after booting  there are too
many destinations or print
queues defined. 
1. Run HP ScanJet 4Si
Administrative Software to
remove some of them from the
scanner configuration and reset
the network scanner.

If the error message shows up
when the MENU or START key
is pressed  for the selected
destination, it means that the
destination has too many
settings defined for the network
scanner. 
1. Run the ScanJet 4Si Network
Utility Software to remove some
settings and reset the network
scanner.

Internal error
(121) ScanJet 4Si halted

Internal error. Power cycle the scanner. If the
problem persists, replace the
network box.

Internal error
(122-124) ScanJet 4Si halted

Error accessing internal scanner
memory.

Power cycle the scanner. If the
problem persists, replace the
network box.

Internal error
(125) Press any key...

The diagnostic module did not
run correctly.

Power cycle the scanner. If the
problem persists, replace the
network box.

Internal error
(211) ScanJet 4Si halted

Internal memory error Execute the following steps
1. Turn the scanner and network
box off and then on again.
2. Check the current user
settings, reducing the
resolution/scaling in order to
reduce the amount of data
generated.
3. If the problem persists,
replace the network box.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Invalid destination (109) Press
any key.

The destination selected does
not exist.

The NetWare user (OT_USER)
is no longer defined in the
server bindery. 
1. Run HP ScanJet 4Si
Administrative Software to
remove the destination name
from the network scanner user
pool 
2. Reset the scanner.

Legal paper selected The document you have
selected to scan is on legal-size
paper.

No action needed.

Letter paper selected The document you have
selected to scan is on letter-size
paper.

No action needed.

Network error (150-153) There is a problem with the
network.
150: Error loading or connecting
to the network stack (Ethernet)
Problem accessing ring (Token
Ring only) 
151: Problem reading
connection status or setting the
connection as primary
152: Error initializing SNMP or
when MIB is registered
153: Error initializing SAP

1. Power cycle the scanner
2. Token Ring networks: Check if
the network cable is connected.
3. If the error persists, replace the
network box.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Network error (155) Press any
key...

Error locking the file on the
server.

If the error occurs at boot
time,  the file HPSSCAN\
HPSSUSRS.CFG is locked by
some other process on the
network (HP ScanJet 4Si
Administrative Software or the
HP ScanJet 4Si Utility software). 
1. Power cycle the scanner. 
2. If the error persists, remove
the file lock with NetWare
administrator tools or check if
the file is not there.

If the error occurs at run time,
the locked file in the private or
the system CONFIGS.CFG file.
To solve the error, repeat steps
1 and 2 above.

Check if the following files exist
and are not locked:
HPSSCAN\CONFIGS.CFG,
HPSSCAN\HPSSUSRS.CFG,
HPSSCAN\USERS\<workarea>
\CONFIGS.CFG

Network error (156) Press any
key...

Cannot open private
configuration file.

1. Ensure that a file called
CONFIGS.CFG exists in the
selected destination workarea.
2. Ensure the scanner has the
READ trustee in the selected
destination workarea. If not, run
HP ScanJet 4Si Administrative
Software to delete and reassign
the same destination to the
network scanner.
3. Ensure the file is not locked.
Ask network administrator to
remove the destination user with
HP ScanJet 4Si Administrative
Software, delete the workarea
and recreate the same user.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Network error (157) Press any
key...

The scanner found an error
synchronizing date & time with
the server. Error reading server
date & time 

1. Check if the server date and
time clock is working correctly.
2. Check if the network scanner
object still exists in the server
bindery. Server date and time is
used to generate HPS file
names; if the read fails no name
is generated.

Network error (158) Press any
key...

Cannot generate an unique file
name for a scanner document
on the server disk

Check if the server date and
time are correctly set. This error
happens if the server clock has
been set to a value back in time.
1. Force the network
administrator to set the server
clock at the right time: today,
now!
Going backward in time could
mean that the same filenames
are generated. When an HPS
file is created and a file with the
same name exists, the creation
fails.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Network error (159) Press any
key...

Error opening the HPS file at
the end of the pages
transmission. At the beginning
of the transmission the HPS file
is created and locked. When all
the pages are sent, the HPS file
is opened and filled with pages
information. The error is
generated if the open fails

1. Ensure the workarea owned
by the selected destination still
exists on the server disk.
2. Check if the server disk is full.
3. Check if the maximum
available disk space for the
workarea owner has been
reached.
4. Check if the scanner has
CREATE, WRITE, FILESCAN,
and READ permissions in the
workarea owned by the selected
destination. 
5. If the trustees have been
removed, add them using
NetWare tools or run HP
ScanJet 4Si Utility and reassign
the same user/destination to the
network scanner.
6. Check if the network scanner
object still exists in the server
bindery.

Network error(160) Press any
key ...

Error creating or opening file on
the server disk. This error
happens when a file cannot be
created in the destination
workarea

1. Ensure the workarea owned
by the selected destination still
exists on the server disk.
2. Check if the server disk is full.
3. Check if the maximum
available disk space for the
workarea owner has been
reached.
4. Check if the scanner has
CREATE, WRITE, FILESCAN,
and READ permissions in the
workarea owned by the selected
destination. 
5. If the trustees have been
removed, add them using
NetWare tools or run HP
ScanJet 4Si Utility and reassign
the same user/destination to the
network scanner.
6. Check if the network scanner
object still exists in the server
bindery.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Network error (161) Press any
key...

Error writing the contents of a
page file (TIFF file)

1. Ensure the workarea owned
by the selected destination still
exists on the server disk.
2. Check if the server disk is full.
3. Check if the maximum
available disk space for the
workarea owner has not been
reached.
4. Check if the scanner has
CREATE and WRITE
permissions in the workarea
owned by the selected
destination. 
5. If the trustees have been
removed, add them using
NetWare tools or run HP
ScanJet 4Si Utility and reassign
the same user/destination to the
network scanner.
6. Check if the network scanner
object still exists in the server
Bindery.
7. If this error shows up at boot
time, ensure the
HPSSUSRS.CFG file exists
under the HPSSCAN directory
on volume zero.

Network error (162) Press any
key...

The private file holding settings
is corrupted.  One of the
following keyword has not been
found in the private
configuration file: “PConf,”
“TConf,” or “Lock.”

1. Run the HP ScanJet 4Si
Utility software to see if private
configurations are read correctly.
2. Delete destination user with
HP ScanJet 4Si Administrative
Software, remove the workarea
and create the user again.
3. Open the HPSSCAN\
USERS\<workarea>
\CONFIGS.CFG and check if
the keywords exist, and if they
are correctly set.

Network error (163) Press any
key...

Network card diagnostic failed. Power cycle the scanner.  If the
problem persists, replace the
network box.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Network error (164) Press any
key...

Impossible to read primary
volume name from network
server.

1. Power cycle the scanner.
2. Check server primary volume
status and name. Preferred
name is “SYS”.
3. Ensure the volume 0 has a
valid name

Next page?  Continue=<l> 
Stop & Save = \/ Abort= //

The scanner is asking the user
to insert the next page on the
scanner glass and to press an
appropriate key to continue.

Press <l> to continue, \/ to stop
and save the data, or // to abort
and lose the data.

Next side?  Continue=<l> 
Stop & Save = \/ Abort= //

The scanner is asking the user
to press an appropriate key to
continue your duplex job.

Press <l> to continue, \/ to stop
and save the data, or // to abort
and lose the data.

No paper feeder The ADF is not properly
connected.

1. Check all cable connections.
2. Try turning the scanner off
and on again. 
3. If error persists: it is not clear
if the problem is in the ADF or
the scanner. The entire unit
should be exchanged.

No preferred setting (107) Press
any key...

The preferred configuration is
undefined,  missing, or
corrupted.

Select a preferred setting on the
control panel.  If you would like
to scan in the future without
selecting a setting at the control
panel, select a setting as
preferred following the
instructions in Chapter 2.
1. Find preferred configuration
name (PConf) and attribute
(TConf) from the private
configuration file (HPSSCAN\
USERS \<workarea>
\CONFIGS.CFG) and check if
the configuration is defined. 
2. If the preferred configuration
is not defined, assign to PConf
a name of some system
configuration and try again to
see if the error still appears.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

No settings found (106) Press
any key...

There are no settings for the
user (destination) selected.
All the configurations owned by
the selected user are corrupted
and there are no system
configurations.

Run HP ScanJet 4Si
Administrative Software to
define at least one system
setting, which will be visible to
all the users/destinations.
1. Remove the user from the
network scanner user pool and
erase his/her workarea.
2. Assign the user again to the
network scanner and see if the
error is resolved.
3. If the error is not resolved,
erase the HPSSCAN\
CONFIGS.CFG (system
configurations) file and use HP
ScanJet 4Si Administrative
Software to create a new one.

No users found No users have been associated
with the scanner.
The network scanner doesn’t
have any assigned user
because the user pool is empty
or because all the users have
some configuration problem

The scanner must have at least
one user/destination.
1. Run the HP ScanJet 4Si
Administrative Software and
designate a user/destination
(see Chapter 2).
2. If users have been defined
and no users are loaded from
the network scanner it is a
configuration problem. All the
user workareas must be erased,
together with the
HPSSUSRS.CFG file. 
3. Unconfigure the scanner with
the special key combination:
PAPER SIZE, DUPLEX and
LEFT ARROW. 
4. Reinitialize the system with
HP ScanJet 4Si Administrative
Software.

Open the cover 
and remove the paper

After a Stop or Abort command,
the scanner is asking the user
to remove the paper from the
ADF.

Remove the paper.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Pages copied: The scanner has finished
copying your document and lists
the total number of pages
copied.

No action needed.

Pages scanned: The scanner has finished
scanning your document and
lists the total number of pages
scanned.

No action needed.

Paper jam!  Open the 
cover & remove paper (204)

A sheet of paper is jammed in
the ADF.

Remove the paper following the
instructions earlier in this
chapter. Replace the ADF and
control panel.

Paper size selected 
from desktop

Any paper selection made at the
control panel is lost because the
user selected a setting with a
custom paper size at the
desktop.

No action needed.

...please wait Internal error booting the system Power cycle the scanner.  If the
problem persists, replace
network box.

Press any key The scanner is waiting for the
user to press a key to confirm
an action.

Press the appropriate key.

Press menu to select A message within the
configuration menus prompting
the system administrator to
select a parameter.

Select the desired parameter;
see Chapter 2 for more
information on using the
configuration menus.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Printer not found (110) Press
any key...

The printer selected is no longer
available. A print queue has
been assigned to the network
scanner and then removed
using NetWare tools.

Run NetWare command
PCONSOLE to check if the print
queue has been deleted or
removed.
1. If it was deleted, recreate the
print queue and assign it to the
scanner using HP ScanJet 4Si
Administrative Software.  
2. Run NetWare PCONSOLE to
check if the scanner has been
removed from the list of queue
users.  If so, run HP ScanJet 4Si
Administrative software to reassign
the print queue to the scanner.

Ready: press menu
to select destination

The system is ready and is
waiting for you to press the
Menu key to start the
destination selection phase.

Press Menu to select the
destination where you want to
send the scanned document.

Rebooting... (101) The scanner is rebooting. No action required.

Reinsert it  Continue <l> Stop \/
Abort //

The scanner is asking the user
to place paper in the ADF.

Place paper in the ADF and
press either <l> to continue, \/ to
stop and save and save the
data, or // to abort and lose the
data.

Reinsert the paper! The user pressed “Continue”
after the first side of a duplex
(2-sided) job was scanned
without reinserting the paper. 

Insert the paper.

ScanJet 4Si unconfigured
(address) (102)

The scanner has not been
connected to the server.

See instructions in Chapter 2.  If
the control panel does not
display a network address,
ensure the following:
1. Network cable is attached
properly and the network box is
on.  
2. Frame type used by the
scanner is the same as that
used by your LAN.  
3. Token Ring speed used by
the scanner is the same as that
used by your LAN.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Scanner error (201) ScanJet 4Si
halted

Error initializing the scanner Execute the following steps
1.  Turn off the scanner and
network box. 
2. Check the SCSI cable
between the scanner and the
network box.
3. Turn on the scanner and
network box. If the problem
persists: it is not clear if the
problem is in the scanner or
network box.  The entire unit
should be exchanged.

Scanner error (205) ScanJet 4Si
halted

Scanner element failed to return
to home position

Execute the following steps
1. Turn off the scanner and turn
it on again to clear the error.
2. If problems persist, replace
the scanner base.

Scanner error (206) ScanJet 4Si
halted

The lamp did not achieve the
required intensity for proper
scanning

Execute the following steps
1. Turn off the scanner and turn
it on again to clear the error.
2. If problems persist, replace
the scanner base.

Scanner error (207) ScanJet 4Si
halted

The connected scanner is an
unknown model.

The user is trying to use a
scanner that is not the correct
HP-issued scanner.

Scanner error (208) ScanJet 4Si
halted

Internal memory error. Execute the following steps
1. Turn off the scanner and turn
it on again to clear the error.
2. If problems persist, replace
network box.

Scanner not connected(202)
ScanJet 4Si halted

Communication problems with
the scanner.  The scanner is not
connected to the network box.

Execute the following steps
1. Turn off the scanner and turn
it on again to clear the error.
2. If the problem persists:  It is
not clear if the problem is in the
scanner or network box.  The
entire unit should be exchanged.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Scanner problems The scanner is not
communicating properly.

1. Turn the scanner off, wait 10
seconds, and turn the scanner
back on. 
2. Power cycle the network box.
3. Make sure that the SCSI
cable between the scanner and
the network box is connected.

Scanning back page The scanner is currently
scanning the back of a
two-sided page.

No action needed.

Scanning front page The scanner is currently
scanning the front of a
two-sided page.

No action needed.

Scanning page The scanner is scanning a page. No action needed.

Self-test
Fail XY

The control panel is not working. Replace the control panel and
ADF.

Self-test
Initializing...wait

The control panel is working but
there is something wrong with
the connection to the network
box.

1. Ensure the cable connecting
the control panel with the network
box is properly plugged in.
2.  If the problem persists:  It is
not clear if the problem is in the
control panel or network box.
The entire unit should be
exchanged.

Setting: The predefined setting selected
appears next to this prompt.

No action needed.

Single-sided selected You have selected to scan a
single-sided (simplex) document.

No action needed.

Stop & Save The scanner is asking if the
user would like to stop scanning
and save the data.

Confirm this action by following
the instructions on the control
panel

Stopped and saved! The user chose to stop the
scanning job but save the data.

No action needed.

Stopped! The user stopped the copying
job.

No action needed.

Stopping & saving... The scanner is terminating the
scanning job and saving the data.

No action needed.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Stopping... The scanner is terminating the
scanning job.

No action needed.

To: The destination selected follows
this prompt.

No action needed.

Transmitting data...
please wait

The scanner is transmitting data. Wait before scanning another
item.

Waiting to attach... (server
name) (103)

The scanner is talking to the
server. The scanner is
configured to attach to the
specified server, but the server
does not answer.

Wait to begin scanning. If the
message persists, check the
following:
1. If the server name printed on
the second line of the control
panel exists and that the server
itself is up and running. 
2. If the network cable is plugged
in to the back of the scanner, and
that the LED is on (Ethernet only).
3. If the frame type used by the
scanner is the same frame used
by your LAN. Use the scanner’s
configuration menu, as shown in
Chapter 2.
4. If you LAN is Token Ring check
if the speed used by the scanner
is the same one used by your
LAN. Use the scanner’s
configuration menu, as shown in
Chapter 2.
5. Check if the maximum number
of licensees for the server has
been reached. 
6. Use special key combination
(PAPER SIZE, DUPLEX AND
LEFT ARROW) to change the
unit back to the unconfigured
state and reconfigure it.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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Control Panel Status/Error
Message

Description Recommended Action

Waiting to login (scanner name) The scanner is identifying itself
to the server. The network
scanner is configured, but the
network scanner object is
unknown to the server. 

Wait to begin scanning. If the
message persists, check the
following:
1. If the scanner name shown
on the second line of the control
panel is the same name given to
the scanner in the HP ScanJet
4Si Administrative Software.
2. If the server where the
scanner is trying to log on has
reached the maximum number
of allowed connections.
3. If the scanner object has
been removed from the server
bindery. In this case the scanner
does not show up in the HP
ScanJet 4Si Administrative
Software.
4. Use special key combination
(PAPER SIZE, DUPLEX AND
LEFT ARROW) to change the
unit back to the unconfigured
state and reconfigure it.

NOTE TO DEALERS:
Unless a module has a visible defect or can be replaced from stock, dealers are advised to
exchange the entire HP ScanJet 4Si scanner unit (see Chapter 1, “Express Exchange Program.”)
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HP ScanJet 4Si Administrative Software Messages

This table lists and describes errors you may have while working with the HP
ScanJet 4Si Administrative Software software and recommends possible solutions
to each error.

Problem or Message Error Description Recommended Action

HP ScanJet 4Si
Administrative
Software  won’t start up

HP ScanJet 4Si Administrative
Software does not support a
version of software you are
using.

Ensure you are using supported software: 
- Windows 3.1x, Windows for Workgroups
  3.11, and Windows ’95 
- NetWare shell NETX V3.26 or above 
- NWNETAPI.DLL 1.30 
- IPX V3.10 or above 
- IPXODI V1.20 or above 
  (only if using ODI) 
- NWIPXSPX.DLL V1.32

Insufficient memory. Free as much memory as possible by
closing other applications.  Try starting HP
ScanJet 4Si Administrative Software again.

IPX protocol is not correctly
installed. 

Ensure your software versions are
supported by HP ScanJet 4Si
Administrative Software. Ensure you’ve
installed and loaded the NetWare protocol
stack software components.  Check if the
versions you’re using are supported by HP
ScanJet 4Si Administrative Software.

NetWare is not correctly
loaded. 

1. Ensure your installation of the NetWare
client software is complete. Make sure
you’ve regularly downloaded all of the
software. 
2. Ensure your software versions are
supported by HP ScanJet 4Si
Administrative Software. 
3. If you have a multi-network environment,
verify that NetWare is one of the activated
NOSs.

While configuring network
scanners on a NetWare 4.x
server, you get an error
message referring to system
directories or file creation . 

Log in from outside HP ScanJet 4Si
Administrative Software.  Older Novell VLM
versions can have problems with NetWare
4.x file servers.  The current release with
NetWare 4.x is 1.20 Novell VLMs.  You can
check your version from the DOS prompt
by typing VLM/? .
If this does not work, try unconfiguring the
affected scanner, then configuring it again.
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Problem or Message Error Description Recommended Action

HP ScanJet 4Si
Administrative
Software won’t start up
(continued)

While logging into a NetWare
4.x server from HP ScanJet
4Si Administrative Software
you get an “Attempt to log in to
the file server failed” message. 

Log in from outside HP ScanJet 4Si
Administrative Software.  Older Novell VLM
versions can have problems with NetWare
4.x file servers.  The current release with
NetWare 4.x is 1.20 Novell VLMs.  You can
check your version from the DOS prompt
by typing VLM/?. 
If this does not work, try unconfiguring the
affected scanner, then configuring it again.

Network scanner list does not
display one or more scanners
you expected to find or
scanner name disappears from
list after setting or changing its
configuration. 

1. Look at the missing scanner’s control
panel.  If the display says “Rebooting...,”
wait for this  phase to be completed and
then refresh the HP ScanJet 4Si
Administrative Software screen
(View/Refresh menu, or F5 key).  Note any
error messages on the control panel and
refer to the appropriate section in this
table. 
2. If the control panel is blank, make sure
the scanner is turned on (check both the
power switches).  Make sure all of the
connections are in place for both the
scanner and the network box. 
3. If this does not work, try unconfiguring
the affected scanner, then configuring it
again. 

Insufficient memory. There’s not enough memory
either to run HP ScanJet 4Si
Administrative Software or to
do a specific operation. 

Free as much memory as possible by
closing other applications.  Try operation
again.

System file may be
corrupted.  Missing
information about user
XXX on server YYY. 

There is a corrupted system
file that contains information
for the designated user on the
designated server. 

Use HP ScanJet 4Si Administrative
Software’s Scanner/Users/Properties to
build the correct data structures for the
user.

The system settings
file is missing,
corrupted or empty. 

The system settings file has
been illegally deleted or edited. 

Use HP ScanJet 4Si Administrative
Software’s  Server/Settings and HP
installation/upgrade toolkit to rebuild the
file.
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Problem or Message Error Description Recommended Action

This operation
requires Supervisor-
equivalent privileges. 

Attempt to log in to the
file server failed. 

This operation requires a log in
on the affected server with
Supervisor-equivalent rights. 

Check the user name and password
you’ve input to HP ScanJet 4Si
Administrative Software. 
Use HP ScanJet 4Si Administrative
Software’s Server/Connect to log into the
server as a user with Supervisor
equivalency.
If the server runs NetWare 4.x, check to
ensure that at least one user is defined
with supervisor equivalency.

This operation
requires you to be
logged in. 

Attempt to attach to
the file server failed. 

This operation requires a log in
on the affected file server. 

Use HP ScanJet 4Si Administrative
Software’s Server/Connect to log into the
server. 
1. Check the network link to the server.
2. Check if the server is correctly up and
running.

This scanner is no
longer responding to
network commands. 

A network command/request
sent from HP ScanJet 4Si
Administrative Software was
not acknowledged by the
scanner. 

Check if the scanner is on and running
correctly.  Try operation again.

This server already
contains a set of users
and printers
associated with this
name. 

You are asking to assign a
scanner a name already
existing in the server internal
database. 

Do not use the same name for different
scanners.  However, answer YES if you’re
reinstalling a repaired/replaced scanner.

Unable to add
directory’s trustee
rights. 

HP ScanJet 4Si Administrative
Software is not able to assign
all the necessary access
permissions to a user’s Work
Area (Note: the user’s name is
displayed at top of the
message). 

Work Area may have been deleted by
mistake. Remove the user from all the
network scanners on that server, then add
the user again.

Unable to copy user’s
file <filepath>. 

HP ScanJet 4Si Administrative
Software can’t copy one of the
user files when the Work Area
is moved to a different volume. 

Check if the server is on and running
correctly, if it is linked to the client system
where HP ScanJet 4Si Administrative
Software is being executed. 
Ensure there is enough storage room for
the files to copy on the destination volume.
Check the volume’s media integrity.

Unable to create
system directory
<directory path>. 

HP ScanJet 4Si Administrative
Software can’t create one of
the system directories. 

Check if the server is on and running
correctly, if it is linked to the client system
where HP ScanJet 4Si Administrative
Software is being executed. 
Ensure the volume 0 is not out of space.
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Problem or Message Error Description Recommended Action

Unable to create the
object in the bindery. 

HP ScanJet 4Si Administrative
Software can’t create the
scanner object on the server. 

Check if the server is on and running
correctly, if it is linked to the client system
where HP ScanJet 4Si Administrative
Software is being executed.

Unable to find a
settings file on this
path. 

The file selected is not
recognized format. 

Check the file path you selected.

Unable to read from
NetWare bindery. 

HP ScanJet 4Si Administrative
Software can’t read from the
scanner object on the server. 

Check if the server is on and running
correctly, if it is linked to the client system
where HP ScanJet 4Si Administrative
Software is being executed. 
If you have some special NetWare tool
allowing to deal with non-standard objects,
the object may have been deleted or
corrupted. In this case, unconfigure the
affected scanner, and configure it again.

Unable to remove the
object from bindery. 

HP ScanJet 4Si Administrative
Software can’t delete the
scanner object on the server. 

Check if the server is on and running
correctly, if it is linked to the client system
where HP ScanJet 4Si Administrative
Software is being executed. 
If you have some special NetWare tool
allowing to deal with non-standard objects,
the object may have been deleted or
corrupted.  

Unable to write
bindery property. 

HP ScanJet 4Si Administrative
Software can’t change the
contents of a scanner object’s
property. 

Check if the server is on and running
correctly, if it is linked to the client system
where HP ScanJet 4Si Administrative
Software is being executed. 
If you have some special NetWare tool
allowing to deal with non-standard objects,
the object may have been deleted or
corrupted. In this case, unconfigure the
affected scanner, and configure it again.
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 HP ScanJet 4Si Utility Messages

This table lists and describes error messages you may receive while working with
the HP ScanJet 4Si Utility and recommends possible solutions for each error.

HP ScanJet 4Si
Utility Error Message

Error Description Recommended Action

A network error
occurred while trying
to determine the work
area status.

A network error occurred while
trying to determine the work
area status.

Ensure user network connections are
present and server is accessible.

Cannot connect to file
server specified in the
NSUAPP.INI file.

HP ScanJet 4Si Utility has
read the name of the server
from the NSUAPP.INI file, but it
is not possible to connect to
the file server specified.

Check that the server name in the
NSUAPP.INI file [Settings] section is the
same one for which the user is configured.
If the server is no longer valid, remove the
value specified after the entry server.

Error in INI file: cannot
find path for
SSNETAPI.DLL

The SSNETAPI.DLL file cannot
be found in the specified
directory.

Check to see that the entry
SSNETAPI_PATH in the NSUAPP.INI file
points to the correct directory and that the
SSNETAPI.DLL is in that directory.

Error Memory
allocation error.

There is not enough memory
for the application to run.

Close any other applications you have
running and try to load the software again.

Error while
enumerating scanners.
Cannot proceed.

A list of scanners on which the
user is configured cannot be
obtained.

The settings file may be corrupt or the
server may be inaccessible. Ensure user
network connections are present and
server is accessible.

Error while obtaining
scanner status
information.

The status of your preferred
scanner cannot be  determined.

Ensure user network connections are
present and server is accessible.

Error while reading
preferred setting.
Cannot proceed.

The preferred setting cannot
be read.

The settings file may be corrupt or the
server may be inaccessible. Ensure user
network connections are present and
server is accessible.

Error while reading
setting values.  Cannot
proceed

The current values for the
setting cannot be read.

The settings file may be corrupt or the
server may be inaccessible. Ensure user
network connections are present and
server is accessible.

Error while reading the
system settings.
Cannot proceed.

The system settings cannot be
read from the file server.

The settings file may be corrupt or the
server may be inaccessible. Ensure user
network connections are present and
server is accessible.
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HP ScanJet 4Si
Utility Error Message

Error Description Recommended Action

Error while reading
user settings. Cannot
proceed.

System setting cannot be read
from the file server.  

The settings file may be corrupt or the
server may be inaccessible. Ensure user
network connections are present and
server is accessible.

Error while trying to
add the new setting.

The new setting cannot be
added to your list.

The settings file may be corrupt or the
server may be inaccessible. Ensure user
network connections are present and
server is accessible.

Error while trying to
perform the requested
operation in the work
area status.

It is not possible to either lock
or unlock your work area.

Ensure user network connections are
present and server is accessible.

Error while trying to
remove the selected
setting.

The setting selected for
removal cannot be deleted.

The settings file may be corrupt or the
server may be inaccessible. Ensure user
network connections are present and
server is accessible.

Error while trying to
set the new preferred
scanner.

The new preferred scanner
cannot be set.

Ensure user network connections are
present and server is accessible.

Error while trying to
set the new preferred
setting.

The new preferred setting
value cannot be set.

The settings file may be corrupt or the
server may be inaccessible. Ensure user
network connections are present and
server is accessible.

Error while trying to
update the setting
values.

The new values for the setting
cannot be saved.

The settings file may be corrupt or the
server may be inaccessible. Ensure user
network connections are present and
server is accessible.

Failed to load
SSNETAPI.DLL.
Application cannot
proceed.

Your computer cannot load this
file.

Make sure you have enough memory to
load a file of this size by loading an
application you have in memory. 

Generic error with
SSNETAPI.DLL

A generic error has been
detected while accessing
resources on the file server or
when transmitting data on the
network.

Ensure user network connections are
present and server is accessible.

HP ScanJet 4Si Utility
does not start when
Visioneer PaperPort
desktop starts.

Visioneer PaperPort desktop
cannot find or load HP ScanJet
4Si Utility application.

Check that the SYSTEM.INI file contains
the entry NSU_EXECUTABLE_PATH in the
section [MaxDrv] and that it contains a
valid directory where NSUAPP.EXE is
present.  If the problem persists, close
some applications to free memory.
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HP ScanJet 4Si
Utility Error Message

Error Description Recommended Action

INI file missing from
Windows directory.
Cannot proceed.

The NSUAPP.INI file cannot be
found in the Windows directory.

Create a new copy of the NSUAPP.INI file
and save it in the Windows directory.

It is impossible to read
the settings files on
the server.  They may
be corrupted or
unavailable.

Your settings file may be
corrupt; HP ScanJet 4Si Utility
cannot read the values for the
settings.

Check to see if file is corrupted.  If it is not
possible to recover this file, recreate your
custom settings.  Make a backup copy of
the new file to avoid having to do this
procedure in the future.

NetWare not loaded NetWare shell is not loaded
with Windows.

Ensure that the SYSTEM.INI file specifies
the network.drv entry.

Network shell error. A generic error has been
detected by the NetWare shell
on your system.

Ensure user network connections are
present.

No preferred setting
has been specified.
This may cause
problems when
scanning.  Please
specify one.

This message appears if your
preferred setting is no longer
available, and the application
cannot set a preferred setting
for you.

Select a preferred setting from the list of
available settings.  If user does not have
any available settings, configure preferred
settings for user.

No scanner is
configured for this
user.  The application
cannot proceed.

HP ScanJet 4Si Utility cannot
find a network scanner that
you are configured to work on.

Ensure the user is configured to work on a
network scanner.  Ensure the user has
been configured for the file server on which
he/she is logged in.

User not configured on
server...

You are not configured to use
the network scanner on the file
server you are using.

Have the user log on to a different server
where he/she is configured or configure the
user for the file server he/she is using.

User not logged in on
server...

You are not logged onto any
NetWare file server.

Have the user log on to a NetWare file
server configured to use the scanner. 
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Visioneer PaperPort Error Messages

This table lists and describes error messages you may receive while working with
the Visioneer PaperPort software and recommends possible solutions for each error.

Error Message Recommended Action

An error was encountered
while receiving a document.

Visioneer PaperPort cannot understand some of the pages it is
attempting to scan.  Try to scan document again.

Cannot load component
<drive>\<directory>\
SSNETAPI.DLL required for
network scanning.

Check to see that the entry SSNETAPI_PATH in the NSUAPP.INI
file points to the correct directory and that the SSNETAPI.DLL is in
that directory.
Edit the SSNETAPI_PATH property in the [MaxDrv] section of the
SYSTEM.INI with the full path to the SSNETAPI.DLL.  Restart
Windows and Visioneer PaperPort.
If SSNETAPI.DLL is not present on the system, uninstall Visioneer
PaperPort and reinstall it as a whole.

Cannot register with network
scanning component because:
<drive>\<directory>\
SSNETAPI.DLL does not have
enough memory.

Close other applications to free memory.  Close and restart
Visioneer PaperPort.

Cannot register with network
scanning component because:
Windows does not have
enough resources.

Close other applications to free memory.  Close and restart
Visioneer PaperPort.

Cannot register with network
scanning component because:
Windows does not have
enough memory.

Close other applications to free memory.  Close and restart
Visioneer PaperPort.

Cannot register with network
scanning component because:
NetWare shell not loaded.

Close Visioneer PaperPort and Windows.  Reboot your system with
the NetWare network.  Restart Windows and Visioneer PaperPort.

Cannot register with network
scanning component because:
user not logged on to file
server.

Close Visioneer PaperPort.  Log on to file server.  Restart Visioneer
PaperPort.

Cannot register with network
scanning component because:
user not configured to use a
network scanner on current file
server(s).

Close Visioneer PaperPort.  Log on to file server where you are
configured to use a network scanner.  Restart Visioneer PaperPort.
If user is not configured, set up user for network scanner use.  See
Chapter 2.

Could not access functions in
<drive>\<directory>\
SSNETAPI.DLL.

Uninstall Visioneer PaperPort and reinstall it as a whole.

5 - 40 Problem Solving EN



Error Message Recommended Action

Document is corrupted and
cannot be deleted.

Clean orphan pages and corrupted data structures using HP
ScanJet 4Si Administrative Software.  Rescan document.

Document is corrupted and
cannot be received.

Clean orphan pages and corrupted data structures using HP
ScanJet 4Si Administrative Software.  Rescan document.

Document is momentarily
locked and cannot be received.
Retry later.

Share data structure may be locked by another user.  Close and
restart Visioneer PaperPort.  If problem persists, try again later.

Internal error: S-<hexadecimal
code>

Close and restart Visioneer PaperPort.
If you receive the error again:
Close and restart Windows and Visioneer PaperPort.
If the error persists, reboot your system, log on to the network, and
restart Windows and Visioneer PaperPort again.

Not enough memory available
to receive document.

Close other applications to free memory.  Try action again.

Windows does not have
enough memory to load
<drive>\<directory>\
SSNETAPI.DLL.

Close other applications to free memory.  Close and restart
Visioneer PaperPort.
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Service and Support
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Hewlett-Packard Service Worldwide

Hewlett-Packard products are sold and supported worldwide through
Hewlett-Packard Sales and Service Offices and through dealers. There are more
than 240 Hewlett-Packard Sales and Service Offices worldwide. To locate the
nearest one, use your phone directory or call one of the Hewlett-Packard regional
offices listed in this chapter.

Customer Support Options US and Canada

Customer Support Assistance (208) 323-2551 Mon-Fri 6 a.m. to 6 p.m. (Mountain Time) Free of charge during the
Warranty Period. Please have your serial number ready when calling.

Post-warranty telephone assistance is available to answer your product questions.
(900) 555-1500 ($2.50** per minute, US only) or call (800) 999-1148 ($25** per
call, Visa or Master Card, US and Canada) Mon-Fri 7 a.m. to 6 p.m. and Saturday
from 9 a.m. to 3 p.m. (Mountain Time) Charges begin only when you connect with a
support technician.

Obtaining Software Utilities and
Electronic Information

Phone: (970) 339-7009 Mail: Hewlett Packard
P.O. Box 1754
Greeley, CO  80632Fax: (970) 330-7655

Internet:  Anonymous FTP: ftp.boi.external.hp.com

World-Wide Web:  URL http://www.hp.com

HPBulletin Board Service: (208) 344-1691 and set your communication software
to N,8,1

America On-Line:  Type HP to start your tour, or call (800) 827-6364 and ask for
representative 1118 to subscribe.

CompuServe: HP forum (GO HP), or call (800) 524-3388 and ask for
representative #51.

Accessories and Supplies (800) 538-8787

HP Support Assistant CD-ROM This support tool offers a comprehensive online information system designed to
provide technical and product information on HP products. To subscribe to this
quarterly service in the US or Canada, call (800) 457-1762.

To Locate HP Authorized Dealers (800) 243-9816 (US) (800) 387-3867 (Canada)

HP Authorized Dealer Support (800) 544-9976 (dealers only)

Parts and Manuals (800) 227-8164 (US) (800) 387-3154 (Canada)

HP Repair Contracts (800) 743-8308 (US) (800) 268-1221 (Canada)

Software Application Notes and Audio Tips

HP FIRST* (800) 333-1917
(208) 344-4809

* HP FIRST (Fax Information Retrieval Support Technology) is a no-charge, 24-hour self-help service that provides answers to
the most common questions about HP products. Through HP FIRST, you can receive ordering information, software
application notes and printer driver update request forms. Simply dial the HP FIRST number from a touch tone phone
connected with a Group 3 Facsimile machine and follow the voice prompts that guide you to select an index of available
support and product documents.

** Prices subject to change without notice.
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Customer Support Options Worldwide

Customer Support Assistance
(language options available)

Dutch +31.20.681.64.73

Danish +31.20.681.61.71

English +31.20.682.82.91 or 0891 391 000

Spanish +31.20.581.33.19 or 906 39 10 00

French +31.20.681.82.60 or 3670 39 49

German +31.20.681.71.74

Italian +31.20.581.33.18

Norwegian +31.20.682.00.94

Finnish +31.20.681.12.14

Swedish +31.20.681.80.25

Japanese 81 3 3335-8333

Mexican (+52 5) 326-45-00 or 91-800-50-198

Obtaining Software Call HP First. World-Wide Web:  
URL http://www.hp.com

Accessories and Supplies Call HP First.

HP Authorized Service Call HP First.

HP Dealer Call HP First.

Software Application Notes

HP FIRST* United Kingdom 0-800-96-02-71

Netherlands 06-02-22-420

Belgium (Dutch) 0800-1-1906

Belgium (French) 0800-1-7043

Germany 0130-8100-61

France 05-90-5900

Spain 900-993123

Italy 1678-59020

Switzerland (German) 155-1527

Switzerland (French) 155-1526

Austria 0660-8128

Finland 9800-13134

Norway 800-11319

Denmark 800-10453

Sweden 020-795743

Taiwan 02-791-5589

China 010-505-5280

Japan 81 3 3335-8622

English outside of U.K. (31) 20-681-5792
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HP Sales and Service Offices

Before calling an HP Sales and Service office, be sure to contact the appropriate
Customer Support Center number listed in the previous table.   To find a
service-authorized HP dealer in the U.S., call (800) 752-0900. To find a
service-authorized HP dealer outside of the U.S. contact one of the following
offices:

Worldwide Hewlett-Packard Sales and Service Offices

Argentina: Before calling an HP Sales and Service
office, be sure to contact the appropriate
Customer Support Center number listed in
the previous table.

Hewlett-Packard Argentina, S.A.
Montaneses 2150
(1428) Buenos Aires
Argentina
Telephone: 541 787-7100
Fax: 541 787-7213

Australia/New Zealand: Austria:

Hewlett-Packard Australia Ltd.
31-41 Joseph Street
Blackburn, Victoria 3130
Australia
Telephone: 61 3 272-2895

Hewlett-Packard Ges.m.b.H.
Lieblgasse 1
P.O. Box 72
A-1222 Vienna
Austria
Telephone: 43 222 2500-0

Belgium: Brazil:

Hewlett-Packard Belgium SA/NV
Boulevard de la Woluwe, 100, Woluwedal
B-1200 Brussels
Belgium
Telephone: 32 2 761 31 11

Hewlett Packard
Alameda Rio Negro 750
06454 - 000 Alphaville - Barueri - S.P. 
Brazil
Telephone: 55 11 726-8000

Canada:

Hewlett-Packard (Canada) Ltd.
17500 Trans-Canada Highway
Kirkland, Quebec H9J 2X8
Canada
Telephone: 1 514 697-4232

Canadian Customer
Information Center: 1 800 387-3867

HP Direct Marketing: 1 416 671-8383

Hardware Service: 1 800 268-1221

Hewlett-Packard (Canada) Ltd.
6877 Goreway Drive
Mississauga, Ontario L4XX 1M8
Canada
Telephone: 1 416 678-9430

Customer Support Center 
(English service only): 1 208 323-2551

Continued on the next page.
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Worldwide Hewlett-Packard Sales and Service Offices, continued

China: Czech Republic:

China Hewlett-Packard Company
5-6/F, West Wing Office
China World Trade Center
No. 1, Jian Guo Men Wai Avenue
Beijing, 100004, China
Telephone: 86 10 505-3888 ext 8800

Hewlett-Packard S.R.O.
Novodvorska 82
14200 Praha 414
Czech Republic
Telephone: 42 (2) 471 73 21

Denmark: European Headquarters:

Hewlett-Packard A/S
Kongevejen 25
DK-3460 Birkerød
Denmark
Telephone: 45 45 99 10 00

Hewlett-Packard S.A.
Route du Nant-d’Avril 150
CH-1227 Meyrin 2 (Geneva)
Switzerland
Telephone: 41 22/780 81 11

Far East Area: Finland:

Hewlett-Packard Asia Pacific Ltd.
17-21/. Shell Tower, Times Square
1 Matheson Street, Causeway Bay 
Hong Kong
Telephone: 852 599-7777

Hewlett-Packard Oy
Piispankalliontie 17
P.O. Box 68
SF-02200 Espoo
Finland
Telephone: 358 0/887 21

France: Germany:

Hewlett-Packard France
28, rue Jacques Ibert
BP 5820 75858 Paris CDEX 17
France
Telephone: 33 (1) 40 89 77 00

Hewlett-Packard GmbH
Herrenberger Strasse 130
W-7030 Böblingen
Germany
Telephone: 49 7031/14-0

Greece: Hungary:

Hewlett-Packard Hellas
62, Kifissias Avenue
GR Maroussi-Athens 15125
Greece
Telephone: 30 1 689 64 11

Hewlett-Packard & Control Kft.
Erzsebet kiralyne utja 1/c 
1118 Budapest
Hungary
Telephone: 36 (1) 142 09 86

Italy: Japan:

Hewlett-Packard Italiana S.p.A.
Via Giuseppe di Vittorio, 9
I-20063 Cernusco sul Naviglio
Milano
Italy
Telephone: 39 2/92 121

Hewlett-Packard Japan
3-29-21, Takaido-Higashi 
Suginami-Ku, Tokyo 168 
Japan
Telephone: 81 3 3335-8333
Fax: 81 3 3335-8338

Continued on the next page.
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Worldwide Hewlett-Packard Sales and Service Offices, continued

Korea: Latin American Sales Region Headquarters:

Samsung Hewlett-Packard Ltd.
11-20th Floors, SHP House
25-12, Yeoeuido-dong, Youngdeungpo-ku
Seoul 150, Korea
Telephone: 82 2 769-0114

Hewlett-Packard Latin America
Monte Pelvoux No. 111
Fracc. Lomas de Virreyes
11000 Mexico D.F.
Mexico
Telephone: 52 5 326-4000

Mexico Guadalajara: Mexico Monterrey:

Hewlett-Packard de Mxico, S.A.
Montemorelos No. 299
Fracc. Loma Bonita 45060
Telephone: 669-95-00

Hewlett-Packard de Mxico, S.A.
Monterry, Nvo. Len
Calz. Del Valle O. No. 409
4° Piso, Col. Del Valle
Garza Garci , 76030
Telephone: 378-42-40

Mexico, D.F.:

Hewlett-Packard de Mxico, S.A.
Prolongacion Reforma 700
Colonia Lomas deSanta Fe 
C.P. 01210 Mexico, D.F.
Mexico
Telephone: (525) 326-4044

Middle East/Africa: Netherlands:

Middle East, Central Africa
Sales Headquarters
Hewlett-Packard S.A.
7, rue du Bois-du-Lan
P.O. Box 364
CH-1217 Meyrin 1 (Geneva)
Switzerland
Telephone: 41 22/780 71 11

Hewlett-Packard Nederland B.V.
Startbaan 16
NL-1187 XR Amstelveen
P.O. Box 667
The Netherlands
Telephone: 31 20/547 69 11

Norway: Poland:

Hewlett-Packard Norge A/S
P.O. Box 34
Østerndalen 16-18
N-1345 Østers
Norway
Telephone: 47 2 87 97 00

Hewlett-Packard Polska Sp. z o.o.
Ul.Newelska Nr. 6
PL-01447 Warszawa
Poland
Telephone: 48 22 37 50 65

Portugal: Russia:

Hewlett-Packard Portugal, S.A.
Rua Gregrio Lopes, Lote 1732A
1400 Lisboa
Portugal
Telephone: 351 1-3017330

Hewlett-Packard
Representative Office
Pokrovski Blvd. 4/17 KV12
101000 Moscow
Russia
Telephone: 7095 923 50 01

Continued on the next page.
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Worldwide Hewlett-Packard Sales and Service Offices, continued

Singapore: Spain:

Hewlett-Packard Singapore (Pte.) Ltd.
150 Beach Rd #29-00 Gateway West
Singapore 0718
Telephone: 65 291-8554

Hewlett-Packard Espaola, S.A.
Madrid
E28230 Las Rozas
Crta. de la Corua, km 16,500
Spain
Telephone: 34 1 626 16 00

Sweden: Switzerland:

Hewlett-Packard Sverige AB
Skalholtsgatan 9
Box 19
S-164 93 Kista
Sweden
Telephone: 46 8/750 20 00

Hewlett-Packard (Schweiz) AG
In der Luberzen
CH-8902 Urdorf
Switzerland
Telephone: 01- 735 72 74
Fax: 01- 735 77 06

Taiwan: Thailand:

Hewlett-Packard Taiwan Ltd.
8F, 337 Fu-Hsing North Road
Taipei, Taiwan R. O.C.
Telephone: 886 2 712 0404

Hewlett-Packard Thailand Ltd.
11th Floor, Pacific Place
140 Sukhumvit Road
Bangkok, 10110
Thailand
Telephone: 66 2 254-6720

Turkey : United Kingdom:

Hewlett-Packard
Bilgisayar ve lm Sistemleri A.S.
19 Mayis cad.Nova/Baran
Plaza K.12 (Headquarters)
80220 S is li-Istanbul
Turkey
Telephone: 90 1 224 59 25

Hewlett-Packard Limited
Cain Road
Bracknell
GB-Berkshire RG12 1HN
United Kingdom
Telephone: 44 344/360000

Venezuela:

Hewlett-Packard de Venezuela, C.A.
3ra. Transversal, Los Ruices Norte
Edificio Segre, Pisos 1, 2 y 3
Caracas 1071, D.F.
Venezuela
Telephone: 582 239-4133
Fax: 582 239-3080
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Frequently Asked Questions
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Technical Questions

The following sections provide brief answers to some frequently asked questions
about the HP ScanJet 4Si scanner. They are intended only as a guide for service and
support engineers.

Key Dates:

•• Ship release: October 2, 1995
•• Introduction: November 1, 1995

General

Who designed the scanner and software?
HP designed the scanner with the help of a development partner.  The software was
developed in partnership with Visioneer.

Can I upgrade my current scanner to a ScanJet 4Si scanner?
No.

Is the scanner ready to operate when it comes out of the box?
The scanner requires some installation and configuration after you unpack it.  The
scanner does not come with a network cable.  For complete information on package
contents, as well as installation and configuration instructions, see Chapter 2.

Installation

Is there a simple installation utility to connect the scanner to the
network?
The HP ScanJet 4Si scanner is easy to install.  The network administrator,
connected to the network with Supervisor equivalence, will be able to install the
scanner with a few easy steps. For complete installation specifications,
requirements, and information, see Chapter 2.

Are any training materials included with the scanner?
The scanner and software come with manuals (User’s Guide, Administrator’s Guide
and Quick Reference Card).  The scanner software also includes online help.

How much space does the software require on end-user PCs?
0.5 MB for remote installation and 8.5 MB for local installation.  For complete
installation specifications, requirements, and information, see Chapter 2.
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Operating System/Software Support

Which Novell network types are supported?

•• NetWare 3.1x or above (4.x in Bindery Emulation)
•• IPX version 3.10 and above
•• NetWare shell version 3.6 and above

For complete installation specifications, requirements, and information, see Chapter 2.

Will NetWare for UNIX work instead of standard NetWare?
No.

Does the scanner support 100 base VG?
No.

Will the scanner work if Windows is installed on the file server
and not locally?
Yes.

What is the difference between a network shared installation and
a local installation?
Speed—during application boot-up, a network installation will take more time. For
more information about shared versus local installation, see Chapter 2.

Does the software require NLMs or ALMs?
No, the scanner software runs as a standard client application.  For more
information see Chapter 4.

What protocols does the scanner support?

•• Ethernet (RJ-45) 
•• Token Ring (RJ-45/DB9)

For more information about network protocols, see Chapter 4.  For information on
scanner features and specifications, see Chapter 1. 

Does the scanner support Windows 95?
Yes. The scanner software is compliant with but not certified for Windows 95. All
the software for the HP ScanJet 4Si scanner can run on Windows 95; however,
some features do not function in Windows 95.  For more information about
Windows 95 support, as well as other supported and non-supported software, see
Chapter 1.
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When will HP’s scanners support other LANs, client operating
systems, color, and other non-supported items?
HP is conducting market research to determine which of these and other items to
support.

Network/Network Management

What network management utilities are provided, and do they
have remote diagnostics?
The scanner comes with HP ScanJet 4Si Administrative software.  Remote re-boot
and status monitoring are possible.

Does the scanner support any other network management tools?
Any tool supporting SNMP will be able to pick up the scanner address and other
similar tasks.

Does the scanner support SNMP and/or Open View?
Yes. The scanner supports SNMP.  Open View also supports SNMP, and therefore,
the scanner can be identified with it.   However, Open View does not allow
extensive control over the scanner.  For more information on scanner features and
specifications, as well as supported and non-supported software, see Chapter 1.

Is there an easy way to clean up or reinstall the scanner hard disk
(after power loss, for example)?
Yes.  Temporary files on the scanner hard disk are cleaned up at power up.
Temporary files found on the file server can be cleaned up using the ScanJet 4Si
Administrative software.  For more information on cleaning up work area files, see
Chapter 5.

Does the scanner have a MIB?
Yes, MIB-II, and a private network scanner MIB.

Can the scanner be managed through HP JetAdmin?
No.  JetAdmin is currently designed for network printer management only.

Does the ScanJet 4Si support the NDS mode?
No. NetWare 4.x LANS are supported only in Bindery Emulation mode.  However,
the ScanJet 4Si can operate on a NetWare 4.x LAN because every NetWare 4.x
server has the Bindery Emulation mode built in.
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Is a toolkit available?
Yes. There are software developer toolkits available for both the network scanner
(SSNet application interface) and for developing Visioneer links to your application.

Performance

How long can I expect the scanner to last?
The duty cycle will vary from scanner to scanner, depending on use, care, and
maintenance.  The scanner has a minimum duty cycle of 130,000 scans.  The target
duty cycle is 200,000 scans.  The estimated mean-time between failure is 10,000
hours.

Will the software provided with the scanner compress scanned
data?
Yes.  The file scanned is compressed by the scanner firmware.  The software
application decompresses and recompresses data in its internal format.  For more
information on scanner data compression, see Chapter 4.

Can users scan documents directly to other users?
Yes.  However, users have the ability to lock their names.  Scanned items cannot be
sent to a locked desktop.  For more information on locking or unlocking a desktop
or changing and overriding user settings, see Chapter 2.

Can a user prevent unwanted documents from being sent?
Yes.  Users can lock their local work areas with the HP ScanJet 4Si Utility
software. For more information on locking or unlocking a desktop or changing and
overriding user settings, see Chapter 2.

What are the scanner settings?
The scanner comes with three preset settings:

•• Best Text
•• Best Text & Photo
•• Best Photo 

Users can create custom settings with the software provided.  For more information
on using and creating scanner settings, see Chapter 2.

How important is grayscale?
Grayscale can be important for DTP use, printing copies of color documents, and
for some OCR applications.  For these instances, grayscale is available as an
optional setting. Users can create custom settings with the software provided.  For
more information on using and creating scanner settings, see Chapter 2.
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What is data compression and when is it used?
G4 is a data compression algorithm that reduces files from 100 KB to 20 KB,
depending on the content of the page.  (For a comparison, fax machines generally
use G3, a lower rate of compression).  For grayscale information, the scanner uses
Packbits compression.  The scanner uses data compression to improve performance
and reduce its impact on the network. For more information on data compression,
see Chapter 4.

If everyone on my 10- to 20-person network starts using a
network scanner for distributing documents,  how will it affect
file size and data storage?
Server disk usage is not normally significant because files are transferred to user
areas (usually the user’s c:\ drive) as soon as the client PC connects to the server.
The amount of disk usage is affected by the following factors:

•• how many scanned documents users maintain on their desktops
•• whether users convert files to editable text via OCR
•• the number of scans done at higher resolutions and 4-bit or 8-bit grayscale.

How will the traffic created by scanned images affect network
performance?
The product will act like a common PC client, doing all of the core activity and
buffering within the product itself and sending compressed data onto the network.
Therefore, the network will not be heavily affected. The scanner has no NLM.

How big are the file sizes for scanned images?  Does the file size
create a problem for the LAN?
For most common scans (1-bit, 300 dpi), the rate of compression is 20-30% of the
size of the original, and depends on the type of document being scanned.  The space
required from the network is no bigger than a standard word processing file.  For
more information on data compression and its effect on a network, see Chapter 4.

Where are files scanned to a desktop stored and managed?
Files can be stored on the server or on the client, depending on network setup.

What is the scanner’s maximum data transfer rate?
The scanner will send at whatever rate can be sustained by the network.

What is the range of scan speeds?
The scanner and ADF can scan at up to 15 pages per minute.  For 15 pages, it takes
the scanner 2 minutes and 19 seconds, from the time the Go key is pressed until it
arrives on the PC desktop.  The speed also depends on the client PC.
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What printers are compatible with the scanner?
All PCL5 printers or above. 

Limitations

Why is the scanner limited to 20 users?  Can more be added?
More than 20 users are difficult to scroll through/select from the scanner.
However, more users can be added by buying an additional user license directly
from Visioneer.

Service and Support

What is the scanner warranty?
The scanner has a 1-year Express Exchange warranty plus phone support from
HP’s Customer Support Center.  Additional options, such as on-site service, are
available.  For more information on the Express Exchange program, see Chapter 1.

How will HP service the network scanner?
In the U.S. and most European countries, the scanner will be serviced by the
Express Exchange program. For more information on the Express Exchange
program, see Chapter 1.
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Index

A
annotation, hiding 3-18
automatic document feeder

clearing jams inside 5-6
installing 2-11

B
bindery, new object in 4-3

C
cleaning the scanner 5-8
client requirements 1-12
components, network & software 1-9
compression, data 4-2
configuration menus, entering 2-14
configuration, options 2-26
configuring

display language 2-14
network frame type 2-16
paper size 2-15
scanner 2-13
token ring speed 2-16

contrast 3-10
control panel messages 5-14
copy functionality (scan to print) 4-4

enabling 2-26
customer support options

Canada 6-2
Europe 6-3
United States 6-2

D
data compression 4-2
default properties

changing and overriding 2-27
deleting excess work area files 5-12
delivery guide sheet, replacing 5-9
description, scanner 1-2
display language, configuring 2-14

E
e-mail

displaying 3-20
link, description of 3-19
preferences 3-25

enabling copying 2-26
end user software, installing 2-24
environmental ranges 1-8
environments

supported & non-supported 1-13
error messages

control panel 5-14
ScanJet 4Si Administrative Software

5-33
ScanJet 4Si Utility 5-37
Visioneer PaperPort 5-40

European customer support 6-3
exchange assemblies 1-7

F
fax

link, description of 3-23
preferences 3-26
reading from PaperPort 3-23

file server requirements 1-12

H
HP

sales and service offices 6-4
HP FIRST

Canada 6-2
United States 6-2

HP ScanJet 4Si Administrative
Software

error messages 5-33
file organization on server 1-11
installing 2-19
restoring scanner defaults 5-13

HP ScanJet 4Si Utility
installing 2-19
restoring scanner defaults 5-13
software messages 5-37

HP worldwide service 6-2

I
identifying scanner parts 2-6
installation, shared vs. local 2-20
installing scanner software 2-19
intensity 3-10

L
link to printer 3-18
links

basic steps 3-17
e-mail 3-19
fax 3-15, 3-23
graphics 3-15
groupware applications 3-15
how to use 3-15
OCR applications 3-15
preferences 3-24
supported 1-14, 3-15
wildcard 3-24
word processing 3-15

local installation 2-20
location requirements 2-3
locking the user’s workarea 2-27
lower roller, replacing 5-10

M
maintaining the scanner 5-8
market positioning, scanner 1-2
module exchange 1-7
module exchange, 

tools for diagnosis 1-6

N
network

components 1-9
copy functionality 4-4
data compression 4-2
file organization 1-11
file server requirements 1-12
new object in Bindery 4-3
no NLM loaded 4-2
protocols 1-11
scan-to-print 4-4
service advertise protocol 4-3
software components 1-10
system architecture 1-9

network box
assembling with scanner 2-9

network frame type, configuring 2-16
network performance

scanner impact 4-2
network scanning 1-3
network, connecting to 2-21
non-supported environments 1-13

O
OCR

converting text 3-22
link, description of 3-21
preferences 3-26
selecting different link 3-22

P
package contents 2-5
paper jams

clearing at end of page 5-5
clearing at start of page 5-4
clearing inside ADF 5-6

paper sizes
configuring default 2-15
supported 1-4

parts, replacement 1-5
phone numbers

obtaining software 6-2
support in US 6-2
support worldwide 6-3

photo
scanning 3-8

print
items 3-18
options 3-18
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printer link 3-18
printing scanned items 2-26
product description  1-2
protocols, network 1-11

R
reinitializing the scanner 5-13
relocking the scanner 2-10
replacement parts/accessories 1-5
replacing

delivery guide sheet 5-9
lower roller 5-10

replacing the scanner 5-13
requirements, location 2-3
resetting the scanner 5-13
resolution 3-10
restoring scanner defaults 5-13

S
sales and service offices 6-4
scaling 3-10
scan-to-print 4-4

enabling 2-26
scanner

adding users to 2-23
assembling network box 2-9
background information 1-2
configuration 2-13
connecting to network 2-21
control panel messages 5-14
diagnosing problems 1-6
effects on network 4-1 - 4-4
environmental ranges 1-8
exchange assemblies 1-7
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